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~ WARNING ~
Thank you for purchasing automation equipment from Automationdirect.com®, doing business as, 
AutomationDirect. We want your new automation equipment to operate safely. Anyone who installs or 
uses this equipment should read this publication (and any other relevant publications) before installing or 
operating the equipment.

To minimize the risk of potential safety problems, you should follow all applicable local and national 
codes that regulate the installation and operation of your equipment. These codes vary from area to area 
and usually change with time. It is your responsibility to determine which codes should be followed, and 
to verify that the equipment, installation, and operation is in compliance with the latest revision of these 
codes.

At a minimum, you should follow all applicable sections of the National Fire Code, National Electrical 
Code, and the codes of the National Electrical Manufacturer’s Association (NEMA). There may be local 
regulatory or government offices that can also help determine which codes and standards are necessary for 
safe installation and operation.

Equipment damage or serious injury to personnel can result from the failure to follow all applicable codes 
and standards. We do not guarantee the products described in this publication are suitable for your 
particular application, nor do we assume any responsibility for your product design, installation, or 
operation.

Our products are not fault-tolerant and are not designed, manufactured or intended for use or resale as 
on-line control equipment in hazardous environments requiring fail-safe performance, such as in the 
operation of nuclear facilities, aircraft navigation or communication systems, air traffic control, direct life 
support machines, or weapons systems, in which the failure of the product could lead directly to death, 
personal injury, or severe physical or environmental damage (“High Risk Activities”). AutomationDirect 
specifically disclaims any expressed or implied warranty of fitness for High Risk Activities.

For additional warranty and safety information, see the Terms and Conditions section of our catalog. If 
you have any questions concerning the installation or operation of this equipment, or if you need 
additional information, please call us at 770-844-4200.

This publication is based on information that was available at the time it was printed. At 
AutomationDirect we constantly strive to improve our products and services, so we reserve the right to 
make changes to the products and/or publications at any time without notice and without any obligation. 
This publication may also discuss features that may not be available in certain revisions of the product.

Trademarks
This publication may contain references to products produced and/or offered by other companies. The 
product and company names may be trademarked and are the sole property of their respective owners. 
AutomationDirect disclaims any proprietary interest in the marks and names of others.

Copyright 2018, Automationdirect.com® Incorporated 
All Rights Reserved

No part of this manual shall be copied, reproduced, or transmitted in any way without the prior, written 
consent of Automationdirect.com® Incorporated. AutomationDirect retains the exclusive rights to all 
information included in this document.



~ ADVERTENCIA ~
Gracias por comprar equipo de automatización de Automationdirect.com®. Deseamos que su nuevo equipo de 
automatización opere de manera segura. Cualquier persona que instale o use este equipo debe leer esta 
publicación (y cualquier otra publicación pertinente) antes de instalar u operar el equipo.

Para reducir al mínimo el riesgo debido a problemas de seguridad, debe seguir todos los códigos de seguridad 
locales o nacionales aplicables  que regulan la instalación y operación de su equipo. Estos códigos varian de área 
en área y usualmente cambian con el tiempo. Es su responsabilidad  determinar cuales códigos deben ser 
seguidos y verificar que el equipo, instalación y operación estén en cumplimiento con la revisión mas reciente 
de estos códigos.

Como mínimo, debe seguir las secciones aplicables del Código Nacional de Incendio, Código Nacional 
Eléctrico, y los códigos de (NEMA) la Asociación Nacional de Fabricantes Eléctricos  de USA. Puede haber 
oficinas de normas locales o del gobierno que pueden ayudar a determinar cuales códigos y normas son necesarios 
para una instalación y operación segura.

Si no se siguen todos los códigos y normas aplicables, puede resultar en daños al equipo o lesiones serias a 
personas.  No garantizamos los productos descritos en esta publicación para ser adecuados para su aplicación en 
particular, ni asumimos ninguna responsabilidad por el diseño de su producto, la instalación u operación.

Nuestros productos no son tolerantes a fallas y no han sido diseñados, fabricados o intencionados para uso o 
reventa como equipo de control en línea en ambientes  peligrosos que requieren una ejecución sin fallas, tales 
como operación en instalaciones nucleares, sistemas de navegación aérea, o de comunicación, control de tráfico 
aéreo,  máquinas de soporte de vida o sistemas de armamentos en las cuales la falla del producto puede resultar 
directamente en muerte, heridas personales, o daños físicos o ambientales severos (“Actividades de Alto Riesgo”).  
Automationdirect.com específicamente rechaza cualquier garantía ya sea expresada o implicada para 
actividades de alto riesgo.									       
Para información adicional acerca de garantía e información de seguridad, vea la sección de Términos y 
Condiciones de nuestro catálogo.  Si tiene alguna pregunta sobre instalación u operación de este equipo, o si 
necesita información adicional, por favor llámenos al  número 770-844-4200 en Estados Unidos.		
Esta publicación está basada en la información disponible al momento de impresión.  En Automationdirect.
com nos esforzamos constantemente para mejorar nuestros productos y servicios, así que nos reservamos el 
derecho de hacer cambios al producto y/o a las publicaciones en cualquier momento sin notificación  y sin 
ninguna obligación.  Esta publicación también puede discutir características que no estén disponibles en ciertas 
revisiones del producto.

Marcas Registradas
Esta publicación puede contener referencias a productos producidos y/u ofrecidos por otras compañías.  Los nombres de las 
compañías y productos pueden tener marcas registradas y son propiedad única de sus respectivos dueños.  Automationdirect.com, 
renuncia cualquier interés propietario en las marcas y nombres de otros.

PROPIEDAD LITERARIA 2018, AUTOMATIONDIRECT.COM® INCORPORATED
Todos los derechos reservados

No se permite copiar, reproducir, o transmitir de ninguna forma ninguna parte de este manual sin previo consentimiento por escrito 
de Automationdirect.com® Incorprated.  Automationdirect.com retiene los derechos exclusivos a toda la información incluida en 
este documento. Los usuarios de este equipo pueden copiar este documento  solamente para instalar, configurar y mantener el equipo 
correspondiente. También las instituciones de enseñanza pueden usar este manual para propósitos educativos.



~ AVERTISSEMENT ~
Nous vous remercions d’avoir acheté l’équipement d’automatisation de Automationdirect.com®, en faisant des 
affaires comme, AutomationDirect. Nous tenons à ce que votre nouvel équipement d’automatisation fonctionne en 
toute sécurité. Toute personne qui installe ou utilise cet équipement doit lire la présente publication (et toutes les 
autres publications pertinentes) avant de l’installer ou de l’utiliser.

Afin de réduire au minimum le risque d’éventuels problèmes de sécurité, vous devez respecter tous les codes locaux et 
nationaux applicables régissant l’installation et le fonctionnement de votre équipement. Ces codes diffèrent d’une 
région à l’autre et, habituellement, évoluent au fil du temps. Il vous incombe de déterminer les codes à respecter et 
de vous assurer que l’équipement, l’installation et le fonctionnement sont conformes aux exigences de la version la 
plus récente de ces codes.

Vous devez, à tout le moins, respecter toutes les sections applicables du Code national de prévention des incendies, 
du Code national de l’électricité et des codes de la National Electrical Manufacturer’s Association (NEMA). Des 
organismes de réglementation ou des services gouvernementaux locaux peuvent également vous aider à déterminer 
les codes ainsi que les normes à respecter pour assurer une installation et un fonctionnement sûrs. 

L’omission de respecter la totalité des codes et des normes applicables peut entraîner des dommages à l’équipement 
ou causer de graves blessures au personnel. Nous ne garantissons pas que les produits décrits dans cette publication 
conviennent à votre application particulière et nous n’assumons aucune responsabilité à l’égard de la conception, de 
l’installation ou du fonctionnement de votre produit.

Nos produits ne sont pas insensibles aux défaillances et ne sont ni conçus ni fabriqués pour l’utilisation ou la revente 
en tant qu’équipement de commande en ligne dans des environnements dangereux nécessitant une sécurité absolue, 
par exemple, l’exploitation d’installations nucléaires, les systèmes de navigation aérienne ou de communication, le 
contrôle de la circulation aérienne, les équipements de survie ou les systèmes d’armes, pour lesquels la défaillance du 
produit peut provoquer la mort, des blessures corporelles ou de graves dommages matériels ou environnementaux 
(«activités à risque élevé»). La société AutomationDirect nie toute garantie expresse ou implicite d’aptitude à 
l’emploi en ce qui a trait aux activités à risque élevé.

Pour des renseignements additionnels touchant la garantie et la sécurité, veuillez consulter la section Modalités et 
conditions de notre documentation. Si vous avez des questions au sujet de l’installation ou du fonctionnement de cet 
équipement, ou encore si vous avez besoin de renseignements supplémentaires, n’hésitez pas à nous téléphoner au 
770-844-4200.

Cette publication s’appuie sur l’information qui était disponible au moment de l’impression. À la société 
AutomationDirect, nous nous efforçons constamment d’améliorer nos produits et services. C’est pourquoi nous 
nous réservons le droit d’apporter des modifications aux produits ou aux publications en tout temps, sans préavis ni 
quelque obligation que ce soit. La présente publication peut aussi porter sur des caractéristiques susceptibles de ne 
pas être offertes dans certaines versions révisées du produit.

Marques de commerce
La présente publication peut contenir des références à des produits fabriqués ou offerts par d’autres entreprises. Les 
désignations des produits et des entreprises peuvent être des marques de commerce et appartiennent exclusivement à 
leurs propriétaires respectifs. AutomationDirect nie tout intérêt dans les autres marques et désignations.

Copyright 2018, Automationdirect.com® Incorporated
Tous droits réservés

Nulle partie de ce manuel ne doit être copiée, reproduite ou transmise de quelque façon que ce soit sans le 
consentement préalable écrit de la société Automationdirect.com® Incorporated. AutomationDirect conserve les 
droits exclusifs à l’égard de tous les renseignements contenus dans le présent document.
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Chapter 1: Introduction

Introduction
Purpose of this Manual

This manual describes how to use the Ethernet Remote Master (ERM) Modules. You will find 
information about:

•	 Configuring the ERM module

•	 Network layouts and cabling

•	 Maintenance and troubleshooting

Other Reference Materials
•	 Do-more! User Manual, part number H2-DM-M

•	 DL205 User Manual, part number D2-USER-M

•	 DL405 User Manual, part number D4-USER-M

•	 Ethernet Base Controller Manual (DL205/DL405), part number H24-EBC-M

•	 Terminator I/O Ethernet Base Controller User Manual, part number T1H-EBC-M

•	 Terminator I/O Installation and I/O User Manual, part number T1K-INST-M

•	 WinPLC User Manual, part number H2-WPLC-M

Who Should Read this Manual
If you need a high-speed Ethernet remote I/O communications link between a DirectLogic 
PLC or WinPLC local base and remote Ethernet slaves and you understand the basics of 
installing and programming PLCs, this is the right manual for you. This manual provides the 
information needed to setup and configure the ERM module and its Ethernet slaves.

Technical Support
We strive to make our manuals the best in the industry. We rely on your feedback to let us 
know if we are reaching our goal. If you cannot find the solution to your particular application, 
or, if for any reason you need technical assistance, please call us at:

770-844-4200

Our technical support group will work with you to answer your questions. They are available 
Monday through Friday from 9:00 A.M. to 6:00 P.M. Eastern Time. We also encourage you 
to visit our web site where you can find technical and non-technical information about our 
products and our company.

http://www.automationdirect.com
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Chapter 1: Introduction

Conventions Used

When you see the “note pad” icon in the left-hand margin, the paragraph to its immediate right will be a 
special note. Notes represent information that may make your work quicker or more efficient. The word 
NOTE: in boldface will mark the beginning of the text.

When you see the “exclamation point” icon in the left-hand margin, the paragraph to its immediate 
right will be a warning. This information could prevent injury, loss of property, or even death in 
extreme cases. Any warning in this manual should be regarded as critical information that should be 
read in its entirety. The word WARNING in boldface will mark the beginning of the text.

Key Topics for Each Chapter
The beginning of each chapter will list the key topics 
that can be found in that chapter.

Getting Started! CHAPTER
1

In This Chapter...

.............................................................................1-2

....................................................................1-3Conventions Used

Introduction
....................................................................1-2Purpose of this Manual

......................................................................1-2About Getting Started!
............................................1-2Supplemental Manuals and Other Help

.............................................................................1-2Technical Support
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Ethernet Remote Master (ERM)
The Ethernet Remote Master (ERM) module provides a low-cost, high-speed Ethernet Remote 
I/O link for DirectLogic 205/405, Do-more! PLC systems, and WinPLC systems. The ERM 
connects the local CPU base(s) to the Ethernet remote slave modules via a 10/100BaseT 
(twisted pair, copper wire) or 10BaseFL (fiber optic) Ethernet link. Each ERM module can 
support up to sixteen slaves when used in DirectLogic 205/405 or Do-more! PLC systems. 
When used in Think & Do WinPLC systems, a limitation of one ERM with one slave applies 
per system.

Ethernet Remote Slaves
The following Ethernet Base Controller (EBC) slave modules and Ethernet Interfaces for 
AC Drives are supported by the ERM module. The remote I/O network may consist of a 
combination of these slaves. The ERM module can support up to sixteen slaves when used in 
DirectLogic 205/405 or Do-more! PLC systems. When used in Think & Do WinPLC systems, 
the ERM module is limited to supporting one slave.

The EBC slave updates all of its I/O data (including analog I/O) internally at a high rate that is 
independent of the rate that the ERM may poll the EBC for its I/O data. This allows the ERM 
to read the most current I/O data regardless of PLC scan times or other slave I/O cycle times.

H2-ERM(100) H2-ERM-F H4-ERM(100) H4-ERM-F

H2-EBC (100, -F) T1H-EBC(100) H4-EBC (-F)

GS-EDRV*

GS-EDRV100*

*For use with AC Drives

Note: The H2-ERM module was 
discontinued in 2014 but is still 
covered in this manual.
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Configuring the Ethernet Remote I/O Network
Use a PC equipped with a 10/100BaseT or 10BaseFL network adapter card and the Ethernet 
Remote Master (ERM) Workbench software configuration utility that comes with this manual 
to configure the ERM module and its slaves over the Ethernet remote I/O network.

Warning: We recommend using a dedicated Ethernet remote I/O network for the ERM and its slaves. 
While Ethernet networks can handle a very large number of data transmissions, and normally handle 
them very quickly, heavy Ethernet traffic can adversely affect the reliability of the slave I/O and the 
speed of the network.

Running the Ethernet Remote I/O Network
Once the ERM I/O network is configured and running, the PC can be removed from the 
network.

PC running ERM Workbench to 
configure the ERM network

DirectLogic or 
Do-more! PLC

GS-EDRV,  
GS-EDRV100 

AC Drive

ERM Module

DL205 I/O

DL405 I/O

Terminator I/O

Dedicated 
Hub(s) for ERM 

Network
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ERM / ECOM Systems
Keep ERM networks, multiple ERM networks and ECOM / office networks isolated from 
one another as shown below. Do not attempt to connect an ECOM module or non ERM 
Workbench PC to a hub that the dedicated ERM network is using. Having an ECOM 
module(s) on an ERM Ethernet network can adversely affect the reliability and the speed of 
the ERM slave I/O.

Dedicated ERM Network

AC Drive

Dedicated 
Hub(s) for ERM 

Network

PC for HMI, 
SCADA, etc.

ECOM or 
Office Network

ECOM Module

PC for Data Acquisition, 
MES, ERP or other 
business systems

GS-EDRV

ERM ECOM
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How the PLC CPU Updates Remote I/O Points
The PLC CPU, ERM and Remote Slave (EBC) modules work together to update the remote 
I/O points. There are three asynchronous scan cycles working together to transfer the remote 
I/O data between the PLC and the I/O modules: the EBC scan, the ERM scan and the PLC 
scan. These are described below. 

During each PLC CPU scan, the ERM is allowed one access to the PLC’s memory. The access 
can be a write to the PLC or a read from the PLC, but not both. There are four types of data 
that are processed: discrete inputs, discrete outputs, analog inputs and analog outputs. The 
ERM can only process one of these four data types on any given scan. If all data types are 
used, it will take four PLC scans to completely update all of the remote I/O points. The largest 
amount of data that the PLC can process in a single request is 128 bytes. If any of the four I/O 
types exceeds 128 bytes of data, it will take multiple scans to process that type’s data.

It is possible for the PLC’s scan to be faster than the ERM’s processing scan. This is largely 
dependent on the size of the application program, as well as the type and number of remote 
I/O points. If there are I/O points that must be updated every PLC scan, it is recommended 
that those points be placed in the CPU base or local expansion base.

1) PLC CPU Scan: executes program logic and scans local I/O. The PLC User Manual 
describes the PLC scan in detail.

2) ERM Scan: there are four I/O types that can be processed by the ERM: discrete inputs, 
discrete outputs, analog inputs and analog outputs. It takes a least one for each of the four I/O 
types present to complete an ERM scan. The typical ERM cycle is as follows:

3) Remote Slave Scan (EBC): constantly collects all discrete and analog input data from the 
input modules in the base. This keeps the most recent input data available whenever the ERM 
requests it. The EBC writes to the output modules as the data is received from the ERM.

In general, it will take four PLC scans to completely update the remote I/O. You can use the 
ladder logic example on page B–5 to get the ERM update statistics. This will provide detailed 
information about the ERM’s processing time.

PLC Scan Process
N Read discrete output data from the PLC

N+1 

Read analog output data from the PLC

Write all of the output data to the EBCs

Collect input data from the EBCs

N+2 Write discrete inputs to the PLC

N+3 Write analog inputs to the PLC
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Frequently Asked Questions
Q. Which protocols are supported by the ERM module?

A.A A protocol is a set of rules that allows computers to connect with one another specifying the format, 
timing, sequencing, and error checking for data packet transmission. The ERM module supports 
Novell IPX and UDP/IP (Universal Datagram Protocol/Internet Protocol). When configuring 
the ERM and EBCs, your PC must support one of these protocols. However, the ERM and 
slaves can utilize their own protocol selection regardless of the protocols supported by your PC.

Q. �Can I create multiple remote I/O networks by putting more than one ERM in 
a single PLC / WinPLC base?

A.A Yes, for DirectLogic and Do-more! PLCs, but Think & Do WinPLC systems are limited to 
one ERM module with one slave per system to ensure reliable system performance. If more 
than one EBC slave is desired in a Think & Do WinPLC system, please contact Entivity’s 
technical support at 734–205–5000 or e–mail info@entivity.com. Be sure to consult Chapter 
2 for important installation information, and be sure not to exceed the PLC power budget 
(see the module specifications in Appendix A and the PLC User Manual). Also, it is very 
important to keep each ERM and its slave(s) isolated from other ERMs and their slaves.

Q. What does it mean to “set up” the ERM module?
A.A The ERM module must be configured using the Ethernet Remote Master 

Workbench to know how many slaves and I/O points there will be on the remote 
I/O network. There are also other advanced ERM settings to configure.

Q. How much remote I/O can I have?
A.A The ERM module supports up to 16 additional DL205/Do-more! EBC bases, 16 Terminator I/O 

EBC systems, 16 fully expanded DL405 EBC systems, Ethernet Interfaces for AC Drives or any 
combination of the four. If a WinPLC is the system interface, the ERM can only support one slave.

Q. Can I reserve slots in a base for future I/O expansion?
A.A Yes, the “Padding” feature within the Slave Configuration window of the 

ERM Workbench allows reserving addresses for future I/O modules at the 
end of each of the EBC slave systems (not between modules).

Q. �Can I program or use an operator interface on the EBC slave when used with 
an ERM?

A.A No, the serial port on the EBC slave is not supported at this time when used with an ERM module.

Q. Which LAN topology should I use?
A.A ERM modules are available for connecting to 10/100BaseT or 10BaseFL (fiber optic) networks. 

The cable distances and environmental conditions often dictate which media type should be 
used. The most popular and flexible topology currently is 10/100BaseT, but 10/100BaseT 
is susceptible to electrical noise and is limited to relatively short cable runs. On the other 
hand, it is very simple and inexpensive, and repeaters can be used to extend its cable length 
limitations. 10BaseFL allows much longer cable runs with immunity to electrical noise. The 
fiber optic cable and hubs are currently more expensive than those for 10/100BaseT.
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ERM/Remote Slave Network Identifiers
This chapter describes the various network identifiers used by the ERM and its slave modules. 
Each module on a network must be uniquely identified. There are three identifiers that can be 
used to make a module unique.

The three module identifiers are:

•	 Module ID

•	 IP (Internet Protocol) Address (a slave may be used on the 
Internet, but I/O cycle time may be very high)

•	 Ethernet Address (MAC Address)

The first two are user-selectable. The third one is set at the factory. A Name may be assigned 
to a module, but the ERM cannot address a slave by its Name.

The identifiers are used to link the ERM module to its remote slaves The decision about which 
type of identifier to use is an important one. Much of the decision depends on the protocol 
requirements of your particular application. Ease of maintenance and troubleshooting also 
must be considered before deciding which type to use.

ERM / Slave Configuration Tools
ERM Workbench software utility must be used to configure the ERM and its slave modules. 
If either Module ID (set by dip switch) or Ethernet Address is used for network identification, 
then ERM Workbench is all that is needed to configure the network modules. ERM Workbench 
is described in detail in Chapter 3.

NetEdit software utility will be needed in addition to the ERM Workbench if IP Addressing 
(UDP/IP) is necessary or if the Module ID is software set. If the H4–EBC slave is used with 
analog I/O or the high speed counter, NetEdit will be required to configure the H4–EBC. 
NetEdit is described in detail in Chapter 4.

Identifiers Protocol How to Set Format Restrictions/Notes

Module ID IPX

DIP Switch Slave Number 1–63, 
Set ERM to 0

Module ID can be changed 
without NetEdit. Disables 
Module ID in NetEdit.

NetEdit
Slave Number 
1-65535
Set ERM to 0

DIP Switch must be set to 
“0”. Must use NetEdit to set 
Module ID.

IP Address UDP/IP NetEdit

4 Three-digit 
Numbers
xxx.xxx.xxx.xxx
(See Page 2–4)

See Your Network 
Administrator, Only for UDP/
IPAdminist

Ethernet Address IPX Set at Factory 12 Hex digits Factory-assigned
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ERM / Slave Module ID
You can assign the Slave Module ID:

•	 Using the DIP switches on the module (1–63).

•	 Using the configuration tools in NetEdit that is included 
within the ERM Workbench utility (1–65535).

Use the DIP switch if you want the ability to install or change slave modules without using 
a PC to set the Module ID. Set the module’s DIP switch, insert the module in the base, and 
connect the network cable. Your Module ID is set on powerup, and your module is ready to 
communicate on the network.

If you prefer to be able to set or change all Module IDs on your network from a single PC, 
use the tools in NetEdit. In chapter 4, we step through the use of NetEdit and the network 
identifier options.

The Module ID equals the sum of the binary values of the slide switches set in the ON position. 
For example, if you set slide switches 1, 2, and 3 to the ON position, the Module ID will be 
14. This is found by adding 8+4+2=14. The maximum value you can set on the DIP switch 
is 32+16+8+4+2+1=63. This is achieved by setting switches 0 through 5 to the ON position.

ON
ON

0

1345678

1234567

Not Used (32)(16)(8) (4) (2) (1)

2

Binary Value

Ignore these numbers

202122232425 .... . .
.... . .

H2–EBC
The numbers (0–7) printed
on the circuit board indicate
the power of 2 represented
by each slide switch.
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IP Address
An IP Address can be assigned to the ERM module or its slaves if your network requires one. 
Normally, a network administrator will assign an IP Address to each device on the network. 
Since it is recommended to use a separate dedicated network for your ERM , you do not 
have to use the IP Address, unless you are using the UDP/IP protocol. Use the Module ID or 
Ethernet Address for each module when using the IPX protocol.

You can use NetEdit within the ERM Workbench utility to give the ERM or its slave modules 
an IP Address. Each ERM and slave must have a unique IP Address.

The module ships from the factory with an IP Address of 255.255.255.255. This is not a 
usable IP Address for normal communications. It only serves as a default setting which can be 
changed using NetEdit. The valid settings are 0 through 254. You do not have to change the 
default IP Address unless you are using IP Address protocol. The default setting does not cause 
conflicts with other network communications.

If you change the default IP Address for linking to other network devices, you must change all 
four “255” fields. If any field contains the number 255 and other fields have been changed, 
the module will not be recognized on the network.

WARNING: There cannot be duplicate IP Addresses on your network. If you are using the IP Address, 
all modules must have a unique number.

Ethernet Address
A unique Ethernet Address is assigned to each module at the factory and will not change. It 
is printed on a label attached to each module. The Ethernet Address is recognized by ERM 
Workbench and NetEdit. The Ethernet Address is a twelve digit number with no deliberate 
relationship to your network or functional areas of your plant. It does not usually serve as a 
convenient and easily remembered identifier for the module.

Using Multiple Network Identifiers
Using one type of identifier does not limit your use of the other identifier types. IP addressing, 
Module ID and Ethernet Addressing may be used on one dedicated remote I/O network.

Valid IP Address: 192.168.100.002
Example

No! 255.168.100.002

Host Auto Prod
H4–ERM
00 E0 62 20 00 85

Host Auto Prod
H2–ERM
00 E0 62 20 00 84

Factory-assigned Ethernet Address
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Inserting the ERM Module in the I/O Base
DL205/Do-more! Slot Choices

The DL205 and Do-more! systems support placement of the ERM module in the CPU-base 
only. It does not support installation of the ERM in local expansion or remote I/O bases. 
The number of usable slots depends on how many slots your base has. See the chart below for 
limitations on slot selection. The D2–230 CPU does not support the ERM modules.

WARNING: Your system can be damaged if you install or remove system components before 
disconnecting the system power. To minimize the risk of equipment damage, electrical shock, or 
personal injury, always disconnect the system power before installing or removing any system 
component.

H2–ERM (100, -F) Module Installation

To install the ERM module, line up the module’s printed circuit board with the grooves in 
the base and push the module until it is flush with face of the base power supply. If you feel 
more than moderate resistance when you push the module into the base, the circuit board 
may not be aligned with the grooves in the base. When the module is firmly seated in the slot, 
depress the top and bottom retaining clips to lock the module in place.

NOTE: When adding modules to your PLC always confirm that your power budget will accommodate the 
added module. See the User Manual for your PLC for more information about calculating the power budget. 
See Appendix A for the power consumption of the ERM modules.

Slot 0 Slot 1 Slot 2 Slot 3 Slot 4

205 CPU

No!

Retaining Clips

205

Module Type CPU Base Usable Slots

H2–ERM(100, -F)

D2-240
D2-250-1
D2-260
D2-262

D2–03B–1, D2–03BDC1–1 1
D2–04B–1, D2–04BDC1–1 1, 2

D2–06B–1, D2–06BDC1–1, D2–06BDC2–1 1, 2, 3, 4

D2–09B–1, D2–09BDC1–1, D2–09BDC2–1 1, 2, 3, 4, 5, 6, 7

H2-DM1 / H2-DM1E Any Base Any Slot
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NOTE: Before installing the ERM module, confirm that your power budget will accommodate the added 
module. See the PLC user manual for your PLC for more information about calculating the power budget. 
See Appendix A for the power consumption of the ERM modules.

DL405 Slot Choices
For PLC systems with D4–430 and D4–440 CPUs, the ERM modules can reside in any 
I/O slot but only in the CPU-base. The D4–450 and D4-454 CPUs allow the installation of 
the ERM module in the CPU-base or in local expansion bases. If the ERM module is used 
in a local expansion base, all bases in the system must be the “–1” type bases. The valid part 
numbers for these bases are D4–04B–1, D4–06B–1, and D4–08B–1. The “–1” on the end of 
the part number indicates that the base supports specialty modules including the ERM. The 
“–1” bases can be connected as local expansion bases or remote bases. They are not the same 
thing. Remote bases do not support the ERM modules!

WARNING: Your system can be damaged if you install or remove system components before 
disconnecting the system power. To minimize the risk of equipment damage, electrical shock, or 
personal injury, always disconnect the system power before installing or removing any system 
component.

405

Slot 0 Slot 1 Slot 2 Slot 3

CPU

Module Type CPU Base Usable CPU-Base 
Slots

Usable Expansion 
Base Slots

H4–ERM(100, -F) D4–430/D4-440

D4–04B, D4–04B–1 0, 1, 2, 3 N/A

D4–06B, D4–06B–1 0, 1, 2, 3, 4, 5 N/A

D4–08B, D4–08B–1 0, 1, 2, 3, 4, 5, 6, 7 N/A

H4–ERM(100, -F) D4–450/D4-454

D4–04B 0, 1, 2, 3 N/A

D4–06B 0, 1, 2, 3, 4, 5 N/A

D4–08B 0, 1, 2, 3, 4, 5, 6, 7 N/A

D4–04B–1 0, 1, 2, 3 0, 1, 2, 3*

D4–06B–1 0, 1, 2, 3, 4, 5 0, 1, 2, 3, 4, 5*

D4–08B–1 0, 1, 2, 3, 4, 5, 6, 7 0, 1, 2, 3, 4, 5, 6, 7*

* You must use the “–1” base for the CPU-base and all local expansion bases.
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H4-ERM(100, -F) Module Installation
To insert the ERM module in a DL405 base, place the bottom tab of the module into the 
notch at the bottom of the base. Pivot the module toward the base as shown below. Ensure 
that each module is tightly seated and secured with the captive screw at the top of the 
module.

Which Modules are Supported in the Ethernet Slaves
The Ethernet remote I/O slaves accept the most commonly used I/O modules for the 
DL205/Do-more!, DL405 systems and Terminator I/O systems (AC, DC, AC/DC, Relay an 
Analog). The table below lists by category those modules that you may use in a remote I/O 
slave. A few specialty modules that are supported in the slaves are listed below.

NOTE: The User Manual for Analog I/O Modules discusses scan times for updating analog I/O data for 
modules installed in local bases. Please be aware that the scan times for updating are different for remote 
I/O modules installed in remote bases. The CPU scan is asynchronous with the remote scan by the master 
module. Thus, an analog input module installed in a remote base, for example, may not have its data 
updated by the CPU “once every scan per channel” as stated in the user manual. The CPU scan may, in 
fact, cycle several times while the remote scan is taking place. Take this into account in applications where 
the timing is critical.

DL405 Base

Disconnect power before installing module!

Module/Unit Remote Slave Module/Unit Remote Slave
PLC CPUs No H2–CTRIO(2) Yes

DC Input Modules Yes D2–CTRINT No

AC Input Modules Yes H4–CTRIO, D4–HSC Yes

AC/DC Input Modules Yes D2–EM No

DC Output Modules Yes Communications and 
Networking Modules No

AC Output Modules Yes

Relay Output Modules Yes

Analog I/O Modules Yes

Thermocouple Module Yes

RTD Module Yes
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ERM Network Layouts
Each ERM module can support up to 16 remote slaves (if a WinPLC system is used, only 
one slave can be supported by the ERM module). The slaves supported are the H4–EBC(–F), 
H2–EBC(–F), T1H–EBC, GS–EDRV100 and HA–EDRV2. A hub or repeater connects 
multiple slaves into a star topology. Multiple hubs or repeaters can be used to create a star–
bus–star topology. Once the ERM I/O network is configured and running, the PC can be 
removed from the network.

Configuring the Ethernet Remote I/O Network
Use a PC equipped with a 10/100BaseT or 10BaseFL network adapter card and the Ethernet 
Remote Master (ERM) Workbench software configuration utility that comes with this 
manual to configure the ERM module and its slaves over the Ethernet remote I/O network.

Running the Ethernet Remote I/O Network
Once the ERM I/O network is configured and running, the PC can be removed from the 
network.

PC running ERM Workbench to 
configure the ERM network

DirectLogic or 
Do-more! PLC

GS-EDRV,  
GS-EDRV100 

AC Drive

ERM Module

DL205 I/O

DL405 I/O

Terminator I/O

Dedicated 
hub(s) for ERM 

Network
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ERM / ECOM Systems
Keep ERM networks, multiple ERM networks and ECOM / office networks isolated from 
one another as shown below. Do not attempt to connect an ECOM module or non ERM 
Workbench PC to a hub that the dedicated ERM network is using. Having an ECOM 
module(s) on an ERM Ethernet network can adversely affect the reliability and the speed of 
the ERM slave I/O.

Warning: We recommend using a dedicated Ethernet remote I/O network for the ERM and its slaves. 
While Ethernet networks can handle a very large number of data transmissions, and normally handle 
them very quickly, heavy Ethernet traffic can adversely affect the reliability of the slave I/O and the 
speed of the network.

Dedicated
ERM Network

ECOM or
Office Network

Keep ERM and ECOM
modules on separate
Networks

E
R
M

E
C
O
M

ECOM

Dedicated Hub(s) 
for ERM Network

PC for HMI or
SCADA, etc.

PC for Data Acquisition
in MES, ERP or other
business systems
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Network Cabling
ERM Supports Three Standards

Three types of ERMs are available. The H2-ERM and H4-ERM support the 10BaseT 
standard. The H2-ERM100 and H4-ERM100 support the 10/100BaseT standard. The 
H2-ERM-F supports the 10BaseFL standard. The 10/100BaseT standard uses twisted pairs 
of copper wire conductors, and the 10BaseFL standard is for fiber optic cabling.

10/100BaseT Networks
The cable used to connect a PLC (or PC) to a hub or repeater is called a patch (straight-
through) cable. The cable used to connect two Ethernet devices (Point–to–Point) together is 
a crossover cable. We recommend that you purchase cables pre-assembled with connectors for 
convenient and reliable networking. 

This diagram illustrates the standard wire positions in the RJ45 connector. We recommend 
all ERM 10/100BaseT cables to be Category 5, UTP cable.

Patch (Straight–through) Cable

Crossover Cable

This diagram illustrates the standard wire positions in the RJ45 connector.
We recommend all ERM 10/100BaseT cables to be Category 5, UTP cable. 

2   TD–
1   TD+

3   RD+
4
5
6   RD–
7
8

3 4 5 621 87

8-pin RJ45 Connector
(8P8C)

54JR54JR

RJ45 RJ45

TD–   2
TD+   1

RD+   3
4
5

RD–   6
7
8

GRN

GRN/WHT

OR/WHT
OR

BLU
BLU/WHT

BRN/WHT
BRN

GRN

GRN/WHT

OR/WHT
OR

BLU
BLU/WHT

BRN/WHT
BRN

TD–   2
TD+   1

RD+   3
4
5

RD–   6
7
8

TD–   2
TD+   1

RD+   3
4
5

RD–   6
7
8

GRN

GRN/WHT

OR/WHT
OR

BLU
BLU/WHT

BRN/WHT
BRN

GRN
GRN/WHT

OR/WHT

OR

BLU
BLU/WHT

BRN/WHT
BRN

10/100BaseT

10/100BaseT
Unshielded twisted-pair 

cable with RJ45 
connectors

10BaseFL
62.5 / 125 MMF fiber 

optics cable with 
ST-style connectors
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10/100BaseT
Most 10/100BaseT hubs or repeaters use a patch (straight-through) cable for connecting 
the network devices (PLCs or PCs). For hub-to-hub connections a crossover type cable is 
commonly required. The figures on the previous page show pin assignments and insulation 
color codes for patch (straight-through) and crossover type Ethernet cables.

UTP Cable
The ERM has an eight-pin modular port that accepts RJ45 type connectors. UTP (Unshielded 
Twisted-Pair) cable is rated according to its data-carrying ability (bandwidth) and is given a 
“category” number. We strongly recommend using a category 5 cable for all ERM connections.

10BaseFL
Each module has two bayonet ST-style connectors. The ST-style connector uses a quick 
release coupling which requires a quarter turn to engage or disengage. The connectors provide 
mechanical and optical alignment of fibers. Each cable segment requires two strands of fiber: 
one to transmit data and one to receive data. The ST-style connectors are used to connect the 
H2–ERM–F or H4–ERM–F module to another H2–ERM–F or H4–ERM–F module or a 
fiber optic hub or repeater.

Fiber Optic Cable
The H2–ERM–F and H4–ERM–F modules accept 62.5/125 multimode fiber optic (MMF) 
cable. The glass core diameter is 62.5 micrometers and the glass cladding is 125 micrometers. 
The fiber optic cable is highly immune to noise and permits communications over much 
greater distances than 10/100BaseT.

Fiber Optic Module ST Connector

Transmit

Receive

Multimode Fiber Optic (MMF) Cable

Ferrule

62.5/125 MMF cable with
bayonet ST-style connectors

Core

Cladding

Fiber cross-section

Sheathing

Transmit Transmit

Receive Receive

Connecting ERM
to Slave
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Maximum Cable Length
The maximum distance per 10/100BaseT cable segment is 100 meters or 328 feet. Repeaters 
extend the distance. Each cable segment attached to a repeater can be up to 100 meters. Two 
repeaters connected together extend the total range to 300 meters. For really long distances, 
consider using Ethernet/Fiber media converters like the SE-MC2U-ST.

The maximum distance per 10BaseFL cable segment is 2,000 meters or 6,560 feet (1.2 
miles). Repeaters extend the distance. Each cable segment attached to a repeater can be 2,000 
meters. Two repeaters connected together extend the total range to 6,000 meters.

10/100Base-T Ethernet Control Network shown 
(also supports 10Base–FL Networks)

100m, max. 
(328 ft.)

100m, max. 
(328 ft.)

100m, max. 
(328 ft.)100m, max. 

(328 ft.)

100m, max.
(328 ft.)

10/100Base-T Hub (required 
if using more than one 
Ethernet slave)
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ERM Workbench Software
Ethernet Remote Master (ERM) Workbench is a software utility that must be used to 
configure the ERM and its remote Ethernet slaves. The ERM Workbench supports two 
methods of configuring the ERM I/O network. Both methods are explained later in this 
chapter. 

The two configuration methods are:

•	 ERM Workbench PLC Wizard – simplifies the ERM I/O network 
configuration procedure when a PLC is used as the CPU Interface.

•	 ERM Workbench – configures an ERM I/O network whether the CPU Interface 
is a PLC or WinPLC, and allows access to all ERM I/O network parameters.

NetEdit, a software utility that can be called from within the ERM Workbench, can be 
used to set the Ethernet master/slave Module ID, set an IP address if necessary or configure 
DL405 EBCs with analog I/O modules. Both ERM Workbench and NetEdit can be used to 
monitor the remote I/O network and to perform diagnostic and troubleshooting tasks.

ERM Workbench software is installed as a utility program when you install DirectSOFT or 
Do-more! Designer. The latest version of ERM Workbench is also available for download 
from Host Engineering’s web site (www.hosteng.com). ERM Workbench consists of several 
files, all of which must be located in the same directory. The installation process places the 
files in the C:\HAPTools directory (default). The files may be placed in another directory, 
but remember all of the ERM Workbench files must be placed within the same directory.

Launching ERM Workbench
There are four methods to launch ERM Workbench:

1.	 Using the Windows Start menu 
Programs>AutomationDirect Tools>ERM 
Workbench (on right) 

2.	 Launching DirectSOFT, then select 
PLC >Tools>ERM Workbench

3.	 Launching DirectSOFT, then select 
Utilities>ERM Workbench (on left)

4.	 Launching Do-more! Designer, 
then select ERM Workbench 
from the Launchpad (on left)
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Adding IPX Network Protocol Support on PCs with Windows XP (32 bit only) 
or Earlier Operating Systems

You may have already set up your PC with selected networking protocols for Ethernet 
communications. If not, you will need to select the protocols now for communication 
with the ERM module. We strongly recommend that you include the IPX protocol. The 
description below applies to Windows 2000 (Windows 98/NT/XP have slightly different 
steps). If you are not familiar with this procedure, you may need to have your Network 
Administrator perform this task.

For Windows 2000, go from My Computer on your Windows desktop to Control Panel. 
Double click on Network and Dial–up Connections, then double click on the desired 
Network Device to see the installed Protocols. If IPX is not listed among the protocols 
already loaded, add it now by clicking on the Install button. For Windows XP, go from 
Start>Settings>Control Panel. The steps are the same as Windows 2000 from this point.

Add the TCP/IP protocol if it is necessary for your application. The TCP/IP selection will 
give you support for the UDP/IP protocol. Also, add the IPX protocol if it is not already 
active.

NOTE: We strongly recommend you load IPX protocol on your PC for the connection from your PC to 
the Ethernet modules. Use UDP/IP in your application, if required,but also add IPX to your list of active 
protocols. Having IPX loaded on your PC gives you a backup for troubleshooting communication problems.
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Running ERM Workbench PLC Wizard
Run ERM Workbench PLC Wizard by launching DirectSOFT or Do-more! Designer, then 
select ERM Workbench as mentioned on the previous page. The Wizard allows the ERM 
network to be easily and completely configured without having to use the more advanced 
ERM Workbench utility.

NOTE: The ERM module and ERM Workbench utility factory default settings are located in Appendix C. 
These defaults will be applied during the ERM network configuration unless otherwise changed. Some 
of the settings can be changed within the ERM PLC Wizard, but all can be changed using the ERM 
Workbench utility.

Step 1: Choosing the ERM Network Configuration
Select either Hub or Point–to–point to describe the ERM network system that will be used. 
This example assumes that a Hub network is used. Once a selection has been made, click on 
the Next button.

Step 2: Connecting the ERM Workbench PC to the ERM Network
Connect the ERM Workbench PC to the dedicated ERM network hub. If only one slave is 
used, connect the PC directly to that slave. Then click on the Next button.
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Establishing Communication with the ERM
The following window will be displayed if an ERM module is found on the network. Click 
on the Flash Error Light button to confirm that the correct ERM module has been found 
(the ERM’s LED will flash for 3 seconds). If the PC is connected directly to the slave in a 
Point–to–point network, this window will not be displayed until the PC is connected directly 
to the ERM module.

Step 3: Select and Configure the Slaves
The Select and Configure Slaves window will display all of the slaves found on the dedicated 
ERM network. The order of how the I/O is mapped into the PLC is based on the slave 
order. The ERM to Slave Address Mode selection determines the address mode in which the 
ERM module will use to communicate with its slaves. Chapter 2 describes the ERM / Slave 
Addressing Modes. Click on the Next button once the slave list is configured.

NOTE: Due to the manner in which I/O is grouped into PLC addresses, it is advisable, for future expansion 
purposes, to pad the base with extra I/O. The wizard does not offer the option to add unused addresses. 
To pad the addresses, add extra I/O before running the wizard. If the padding is not created, adding an I/O 
module to the base in the future will offset a wide range of I/O in the PLC’s memory map. 
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Step 4: Map I/O to PLC Memory
Select the starting PLC memory addresses for each of the four I/O types: Discrete Inputs, 
Discrete Outputs, Analog Inputs and Analog Outputs.  Be sure that the selected starting 
addresses do not conflict with any local I/O or any memory locations used in the ladder 
logic program.  Note that the first two words of memory in the Discrete Input table is 
reserved for ERM status information and the first word of memory in the Discrete Output 
table is reserved for Disable Slave Command bits.  For more detailed information on PLC 
I/O mapping, refer to the “PLC Map” section and the “Reserved PLC Memory for ERM” 
section.  Click on the Next button once the starting PLC addresses have been selected.

Step 5: Download Configuration to ERM

The following window displays how the slave I/O will be mapped into the PLC memory. 
The network I/O modules and I/O points are listed by slave and slot number. This 
configuration is written to the ERM by clicking on the “Write to ERM” button. If any 
advanced configuration needs to be done, click on the ERM Workbench button. The 
modified configuration can then be downloaded from the ERM Workbench utility to the 
ERM module.

DirectLOGIC

Do-more!
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ERM Workbench Main Configuration Window
The ERM Workbench main configuration window will be displayed once the configuration 
is written to the ERM. Refer to the “Write Configuration to ERM” section for a complete 
description of the window fields.

In the Slave Status box, the status of a specific slave can be displayed by clicking on the slave 
number 1–16. The numbers are highlighted in either normal, green, yellow or red. Normal 
(default) indicates that the slave is not configured. Green indicates the ERM is successfully 
communicating with that particular slave. Yellow indicates I/O is updating, but some error 
exists within the I/O of that slave (i.e. module missing 24VDC, unused analog channels exist, 
broken transmitter or module missing terminal block, etc.). Red indicates I/O is not updating 
and that the ERM is not communicating with that slave. Clicking on the Slave’s Error List 
button will display the error conditions for that particular slave. The error codes are then 
defined under the Error List button.
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Running ERM Workbench
First, run the ERM Workbench PLC Wizard by launching DirectSOFT or Do-more! 
Designer, then select ERM Workbench as previously mentioned in the Launching ERM 
Workbench Section. With the wizard opened, click the ERM Workbench button in the 
lower left hand side of the ERM Workbench PLC Wizard window. Checking the “Please do 
Not Launch PLC Wizard at startup” box will disable the Wizard from launching, but can be 
accessed from View menu>PLC Wizard. The following window will be displayed.

Connecting the ERM Workbench PC to the Network Modules
The ERM Workbench PC will need to be connected to the ERM network to configure the 
modules as described in this chapter. A hub is not necessary if only one network slave is used. 
In this case, the PC will need to be connected directly to the slave module to configure the 
slave. Then, the PC will need to be connected directly to the ERM module to configure the 
ERM.
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Configure the ERM
NOTE: The ERM module and ERM Workbench utility factory default settings are located in Appendix C. 
These defaults will be applied during the ERM network configuration unless otherwise changed. The default 
settings can be changed during configuration, module by module, within the ERM Workbench. Also, the 
ERM Workbench> View menu>Options allows the default settings to be change at a system level that will 
apply to all the new module configurations.

Configuring the ERM
Click on “1. Configure ERM” button. Then select either DirectLOGIC PLC, Do-more! PLC 
or WinPLC as the ERM / CPU Interface.

Selecting PLC as Interface
If either PLC is selected, 
the PLC Map is enabled. If 
WinPLC is selected, the PLC 
Map will remain disabled. 
The PLC Map is explained 
on the next page. Clicking 
on the PLC Memory Map 
button displays the valid 
memory ranges for each 
PLC that supports the ERM 
module.
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PLC Map
A starting PLC memory address must be specified for each of the four types of I/O. The 
ending address for each I/O type is determined by the amount of each I/O type used by the 
slaves. The PLC Map is divided into 4 separate tables.

1.	 Discrete Inputs: This is where the ERM will Write all of the slaves’ Discrete Input data.

2.	 �Discrete Outputs: The ERM will Read this from the PLC 
and Write it to the slaves Discrete Outputs.

3.	 Analog Inputs: This is where the ERM will Write all of the slaves’ Analog Input data.

4.	 Analog Outputs: The ERM will Read this from the PLC 
and Write it to the slaves Analog Outputs.

It is recommended to use the V404xx or DLX3xx (X’s) for Discrete inputs and V405xx 
or DLY3xx (Y’s) for Discrete Outputs that are beyond the expansion base I/O that exists. 
The default addresses are V40414 (X300) and V40514 (Y300) for DirectLOGIC users 
and DLX300 and DLY300 for Do-more! users. Note that the Starting PLC address and 
the Starting Discrete I/O Address are not the same. The first two words of memory in the 
Discrete Input table is used for ERM/slave status information, and the first word of memory 
in the Discrete Output table is for Disable Slave Command bits. Adjust these address as 
needed, but do not map over local I/O used and be sure the PLC supports the alternate 
addresses selected.

Advanced ERM Configuration

Clicking on the ERM Configuration “Advance” button displays the following window.

Standby Cycle Time is the time the ERM will wait before trying to communicate with a slave 
that had a communication error. Enabling this feature will help overall I/O throughput when 
one slave errors in a multi–slave network. 
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If the Standby Cycle Time is disabled, the ERM will try to communicate with the slave in 
error every I/O cycle. If enabled, the ERM will try to communicate with the slave in error at 
the given time interval.

PLC Scan Timeout is the time for the ERM to wait on the PLC when the PLC is not 
responding due to long PLC scan times. It is recommended to keep it at the default of 100ms 
or twice the maximum PLC scan time, whichever is greater.

Unsupported Slave Cycle Time is the time the ERM will wait before trying to communicate 
with a slave that cannot be supported by the ERM. An unsupported slave may have an I/O 
configuration that does not match the ERM’s or may have obsolete firmware. If disabled, 
the ERM will not try to communicate with the unsupported slave again until ERM power is 
cycled. If enabled, the ERM will check slave support at the given time interval. If the slave is 
then supported, the slave will be included in the ERM’s I/O cycle.

Advanced ERM Network Settings are used to configure the ERM’s UDP/IP subnet mask for 
IP address handling. Consult your network administrator if needed.

Select the Slaves
Selecting the Slaves

Select “2. Select Slaves” button. In order to select and configure the slaves, the PC running 
ERM Workbench needs to be connected to the specific remote Ethernet slave network.

NOTE: A Think & Do WinPLC can only support one slave per ERM module. A PLC can support up to 
sixteen slaves per ERM modules.

A. �In the upper left corner of the Select Slaves window is a PC Network Slaves on protocol 
group list. Clicking on either the IPX or UDP/IP radio button determines which protocol 
is used by the PC running ERM Workbench to communicate with the remote master and 
slave modules. The ERM and its slave modules understand either protocol. Only one of 
the protocols needs to be installed on the PC to configure the ERM.
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B. �The left column displays the Ethernet Address, IP Address, Module ID and Model number 
of the slaves currently on the remote I/O network. If slaves are added or removed from the 
network, click on the Query Network button (1) to update the list.

C. �The center column displays the ERM’s Slave List. To add a slave to the ERM’s List, either 
double click on a slave in the PC Network Slave List or select the slave and click on the Add 
to Slave List button (2). Slaves can also be removed from the ERM’s List by clicking on the 
Remove button. One ERM can support up to 16 remote slaves.

D. �The right column displays the Slave Configuration of the slave that is selected in the ERM’s 
Slave List. 

E. �NetEdit can be used to assign IP Addresses to the remote I/O network modules if required. 
NetEdit is also required if Module ID is to be software set or if the 405 EBC is used with 
analog I/O modules. Normally, a network administrator will assign an IP Address to each 
module on the network. Since it is recommended to use a dedicated remote I/O network, 
it is not necessary to assign IP Address unless the UDP/IP protocol must be used. Refer to 
Chapter 4 “Using NetEdit” for more information.

Configure the Slaves
Setting the Slave’s Parameters

Remote slave parameters (protocol, address mode, timeout, etc.) are set individually for each 
slave. To configure a slave, select a specific slave in the ERM’s Slave List by either double 
clicking on that slave or by clicking on the “Configure” button once the slave is highlighted. 
The following window will display the settings of the selected slave module.

A.	 The left column, ERM to Slave Communication Settings, determines the protocol, address 
mode and the communication Timeout Settings the ERM module will use to communicate 
with the specific slave selected.
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B.	 In the Protocol box, click on either the IPX or UDP/IP radio button to select which 
protocol the ERM will use to communicate with the selected slave. If UDP/IP protocol 
is selected, a valid IP address must be assigned using NetEdit. The Address Mode 
determines which network identifier will be used by the ERM to address the selected 
slave. IPX protocol supports either Module ID or Ethernet Address. UDP/IP protocol 
supports only IP Addressing.

C.	 ERM Timeout to Slave Response, Retries and Consecutive Failures Before Standby 
Mode times can be set for each slave. The default time values should be adequate for most 
applications. The values may need to be raised in applications where IP addressing and 
routers are used or if a dedicated remote I/O network is not used.

D.	Enabling the Slave’s Watchdog Timeout runs in the slave and allows the slave to turn off 
all outputs when the slave no longer receives any I/O requests from the ERM module. Any 
outputs that were on at the time of the error will turn off after the specified time elapses. 
Set the ERM Pet Frequency runs in the ERM to reset the watchdog timer in the slave to 
avoid any nuisance timeouts due to main CPU inconsistent logic times or ERM I/O cycle 
times. Disabling the slave’s WatchDog timer will cause all of the outputs to remain in their 
last state indefinitely (hold) when the slave no longer receives any I/O requests.

E.	 Reserve PLC Addresses for Expansion allows future I/O modules to be added or existing 
modules to be removed from a slave without affecting the PLC addresses of the other slaves 
on the network. Pad the discrete inputs and outputs using bytes (8 points per byte) and the 
analog I/O using words (2 bytes). Padding can only be done for I/O at the end of a slave 
I/O base, not between two I/O modules on the slave.

F.	 The Make Offline feature may be useful for users or OEMs that require duplicating a 
system several times. For example, a system may consist of 3 EBCs. An offline ERM 
configuration allows each additional ERM to be configured without actually connecting 
its slaves at configuration time. Once the initial ERM system is configured, its ERM 
Workbench configuration file can be used to create another configuration file with different 
slave addresses. Checking the Make Offline checkbox allows slave addresses to be manually 
set that should be used by the ERM. This does not change the address in the slave, but 
changes the ERM configuration to address a different slave without connecting it on the 
network when configuring the ERM.

Once the CPU Interface and Slaves have been selected and configured, the network I/O 
modules and I/O points will be listed by slave and slot number as shown on the next page 
(A.). The next step will be to write the configuration to the ERM module

NOTE: If the slave is configured by a Do-more! CPU, it will report back one extra word that indicates that 
it is talking to a Do-more! processor. Cycle the power to the slave to place the slave back into ERM mode.



Ethernet Remote Master User Manual, 2nd Edition, Rev. C - H24-ERM-M4–14

Chapter 4: Configuring the ERM And Slave Modules with ERM Workbench

Write Configuration to ERM
After the ERM CPU interface has been selected and the slaves have been configured, click on 
the “3. Write to ERM” button to write the configuration information to the ERM module. 
Once the download is complete, the following window can be used to check slave status and 
view detailed ERM status, etc.

A. �Once the CPU Interface and Slaves have been configured using the steps on the previous 
pages, the network I/O modules and I/O points will be listed by slave and slot number. 
This configuration will be written to the ERM by clicking on the “3. Write to ERM” 
button. If using a PLC CPU as the interface, note that the Starting PLC address and 
the Starting Discrete I/O Address are not the same. The first two words of memory 
in the Discrete Input table is reserved for ERM/slave status information, and the first 
word of memory in the Discrete Output table is reserved for Disable Slave Command 
bits. The PLC memory map information is not displayed if a WinPLC is selected as the 
CPU interface. See the following section “Reserved PLC Memory for ERM” for detailed 
information. This table can be sorted by I/O module address or PLC Memory Address.

B. �The top row lists the ERM’s Ethernet Address, IP Address and Module ID. It is highly 
recommended that the Ethernet Address of the modules is placed on a label near the 
module in a visible location.

C. The PLC CPU or WinPLC Interface information is listed.

D. �In the Slave Status box, the status of a specific slave can be displayed by clicking on the 
slave number 1–16. The numbers are highlighted in either normal, green, yellow or red. 
Normal (default) indicates that the slave is not configured. Green indicates the ERM is 
successfully communicating with that particular slave. Yellow indicates I/O is updating, 
but some error exists within the I/O of that slave (i.e. module missing 24VDC, unused 
analog channels exist, broken transmitter or module missing terminal block, etc.). Red 
indicates I/O is not updating and that the ERM is not communicating with that slave. 
Clicking on the Slave’s Error List button will display the error conditions for that 
particular slave. The error codes are then defined under the Error List button.
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E. �When the CPU Interface is in the Run Mode, the Read ERM Status button will be 
highlighted. Each time the button is clicked, the most current ERM Status information 
will be read and displayed.

F. �Detailed ERM Status provides status 
of the module including ERM I/O 
Cycle Times. This is the time required 
for the ERM module to update all of its 
I/O points. Remember the ERM and 
the PLC CPU operate asynchronously 
from one another. The PLC CPU scan 
will be faster than the ERM I/O Cycle 
Time. Thus, the remote I/O points 
will not be updated every PLC CPU 
scan.

Analog I/O Data Registers
Analog I/O Data Registers

Analog input data is mapped channel by channel in decimal format (binary) into consecutive 
memory locations when used in an EBC base. Each individual analog I/O channel has its 
own 16–bit memory location. For example, an 8 channel analog input module with starting 
DirectLOGIC PLC V memory address of V2000 would map the 8 channels of analog data 
into V2000 – V2007, respectively. 

Analog output data needs to be in decimal format (binary). For DirectLOGIC users, be 
sure to convert any BCD values to decimal before sending the data to the analog output 
registers. Refer to the Analog I/O Manuals for conversion examples. Terminator analog I/O 
modules consume two (Double) words per channel (32–bits). See Appendix E for configuring 
Terminator I/O analog output module control byte. 

The EBC slave modules automatically maps the analog I/O data in/out of memory, thus 
multiplexing ladder logic or pointer method is not necessary.

Note that the 205/405 analog I/O 
channels are listed as 16-bit Binary 
consecutive data registers (1 word) and 
the Terminator analog I/O channels are 
listed as 32-bit Binary non-consecutive 
data registers (Double Word).
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Reserved PLC Memory for ERM
The first two words of memory in the Discrete Input table is used for ERM/slave status 
information, and the first word of memory in the Discrete Output table is for Disable Slave 
Command bits. The default memory addresses DLX300/X300 and DLY300/Y300 are used 
in this example.

The Slave Status Bits can 
be monitored to detect if a 

slave is in error.

The ERM Status Word 
contains the ERM error 

code and Status Bits (see the 
following description and 
Error Codes in Appendix 
B). Bit 8 indicates that the 
ERM is disabling a slave.

The Disable Slave Bits can 
be used to disable a slave 

from communicating with 
the ERM module. Bit ON 
= disable that specific slave. 

RESET = re-enable the 
specific slave.
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ERM Status Word / Reset Slave Code
The ERM Status Word contains the current ERM Error Code in the Least Significant Byte 
and the Status Bits in the Most Significant Byte. When using the Slave Disable Bits, the 
ERM must recognize the request to disable a slave before attempting to re–enable that slave. 
This closed loop feedback is necessary due to the asynchronous scans of the ERM and PLC. 
X330 (DLX330 for Do-more!) is the only feedback bit for ALL slave disabling bits (Y300 – 
Y317 or DLY300 – DLY317). Either disable multiple slaves all on the same scan or serialize 
the disable process by using ladder logic interlocks. 

Use the following ladder logic code to manually reset a slave. For example, use this resetting 
method when “Hot Swapping” a Terminator I/O module on a slave that is set up to be 
manually reset using ladder logic. The default for the Terminator EBC is automatic rescan 
after “Hot Swapping” and I/O module.
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Saving ERM Configuration to Disk
The ERM configuration can be saved to disk as an ERM Workbench File (*.erm). The Save 
command allows you to specify a name and location for the configuration. See File>Save.

Clear ERM Configuration
The Clear ERM command allows you to clear the existing configuration from an ERM 
module. This function is useful when changing the ERM network configuration or 
experiencing configuration difficulties. See File>Clear ERM.

Printing/Exporting the ERM Configuration
The ERM Configuration can be printed or exported as a text(.txt) or comma separated 
variable(.csv) file. The ERM Configuration can be sorted by either the Slave/Base/Slot 
Address or the PLC Memory Address. The ERM/Slave Status can also be included with the 
print or export. See File>Print/Export.
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Using NetEdit
The NetEdit Window

NetEdit is a software utility which can be used to set network identifiers (Module ID, or 
IP Address) for the network master and slave modules. NetEdit is accessed from the ERM 
Workbench “Select Slaves” window or the View>NetEdit Window. NetEdit can also be used 
for diagnostic and troubleshooting tasks. This section steps through the individual segments 
of the NetEdit utility and the function of each.

Ethernet Communication Protocol
In the upper left corner of the NetEdit window, 
under the toolbar, you will find there are two 
protocol choices: IPX and TCP/IP. The ERM and 
its slave modules understand IPX and TCP/IP 
protocols. Both protocols are permanently resident 
in the firmware of the modules.

When you click on one of these buttons, you are selecting the protocol you want your PC to 
use to allow NetEdit to communicate with the master or slave modules. You are not telling 
the module which protocol to use. IPX is a Novell standard in widespread use, and TCP/IP 
is a popular protocol supported by the configured protocols in your PC. 

NOTE: The protocol choice in NetEdit tells your PC which protocol to use to link NetEdit to the master or 
slave modules. You are not selecting which protocol the remote I/O network will use.
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Adding IPX Network Protocol Support on PCs with Windows XP (32 bit only) 
or Earlier Operating Systems

You may have already set up your PC with selected networking protocols for Ethernet 
communications. If not, you will need to select the protocols now for communication with the 
ERM module. We strongly recommend that you include the IPX protocol. The description 
below applies to Windows 2000 (Windows 98/NT/XP have slightly different steps). If you are 
not familiar with this procedure, you may need to have your Network Administrator perform 
this task.

For Windows 2000, go from My Computer on your Windows desktop to Control Panel. 
Double click on Network and Dial–up Connections, then double click on the desired Network 
Device to see the installed Protocols. If IPX is not listed among the protocols already loaded, 
add it now by clicking on the Install button. For Windows XP, go from Start>Settings>Control 
Panel. The steps are the same as Windows 2000 from this point.

Add the TCP/IP protocol if it is necessary for your application. The TCP/IP selection will give 
you support for the UDP/IP protocol. Also, add the IPX protocol if it is not already active.

NOTE: We strongly recommend you load IPX protocol on your PC and use it for your module links. Use 
TCP/IP in your application, if required, but also add IPX to your list of active protocols. Having IPX loaded 
on your PC gives you a backup for troubleshooting communication problems.

Ethernet Address
NetEdit lists the Ethernet Addresses along with Module Type, IP Address, Module ID, 
Module Name and Module Description of any modules currently on the remote I/O 
network. 

If modules are added or removed from the network, click on the Scan Network button to 
update the list. Notice that the Ethernet Address is the factory-assigned address that is on the 
permanent label on the module.

Select a specific module here by clicking on the Ethernet Address or by using the arrow keys. 
The selected module is highlighted.
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Module ID / IP Address / Name / Description
To assign a Module ID, IP Address, Name and Description to the module, double-click on 
the specific module to get the General Settings window. In this window you can configure 
the available options. 

Module IDs must be unique for each module, but they do not have to be in sequence. The 
DIP switches must all be set to zero to enable any software to change the Module ID. If not 
set to zero then the Module ID will be read only. 

The Name field and Description field are optional. The ERM cannot address a slave by 
Name or Description.

To set an IP Address, highlight the number in each of the four boxes, and overwrite 
the number. Use the twelve-digit number assigned to the module by your network 
administrator. If you change the IP Address, do not use the number “255” in any field. 
Doing so will cause communication problems.

Clicking the OK button sends all entries to the module’s flash memory.

Module Information
The Module Information box provides the module Version, Booter and Dip switch settings, 
as well as, Ethernet Stats and Errors. 

The Version and Booter refers to the module’s firmware version. The Dip switch setting 
reflects the Module ID.
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NOTE: The module information and settings on this page apply to the selected (highlighted) module. To 
select a module, click on its Ethernet Address in the Module list.

The Ethernet Stats are statistics related to communication errors. These statistics are explored 
in Chapter 6, Maintenance and Troubleshooting.

Click on the Reset Stats button to reset all categories to 0 (zero).

Using NetEdit to Configure the EBC Base
NOTE: The following configuration information applies only to the H4–EBC(–F) and the DL405 I/O. The H2–
EBC(–F) and associated DL205 I/O are self-configuring and do not require this additional step.

EBC Settings Tab
When an EBC is selected from the module list, an EBC Settings tab becomes available, as 
seen below.

The following options are available through this tab:  

•	 General Settings: Set Module ID, Name, Description and IP Address

•	 Serial Port: Configure Serial port communication parameters (Note: the 
serial port is not compatible with an Hx-ERM as the master)

•	 I/O Base: Specify installed analog cards

•	 Show Base Contents: Generate, print and save a report of installed modules

•	 Update Firmware: Load new firmware from file

•	 Update Booter: Load a new booter from file

•	 Restore Factory Defaults: Return configurable options to factory defaults
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General Settings

Assign a module ID: The module ID is only required when the master’s address mode is set 
to Module ID.

Assign a meaningful name and description: These will appear when browsing for convenient 
identification.

Assign an IP address: An IP Address is only required when the master’s address mode is set to 
IP Address.

Serial Port
Set the desired parameters for the serial port. 

NOTE: The serial port is not supported when used with an Hx-ERM or Hx-ERM100 master.

I/O Base
When you click on the I/O Base button, the H4–EBC Base Configuration screen pops up, as 
shown below. The H2–EBC and the T1H–EBC are self-configuring and do not require this 
step.
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The default symbol “----------” appears on the configuration screen where digital or analog 
modules are present. For digital modules, you do not need to make any changes. The H4–
EBC recognizes the digital modules and is self-configuring for the digital modules.

If you are using analog modules, you must let the H4–EBC know that by doing the 
following. Click on the slot location where the analog module is located. Continue clicking 
on the same slot location until the part number of your analog module appears. You can also 
right-click on the slot location to pick the desired module from a list.

Once the correct part numbers are chosen for each of your analog modules, click the OK 
button to save the configuration into flash memory onboard the module. Leave the symbol 
“----------” wherever you have a digital module.

If you are using a D4–HSC High Speed Counter module, the word “Intelligent” will appear 
in gray. The High Speed Counter module is configured automatically and no other action is 
required other than clicking on the OK button.

Show Base Contents
Opens a report of the installed modules which can then be printed or saved.
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Update Firmware
Use this dialog to update the module’s firmware. Pick the firmware file from disk. Firmware 
files may be downloaded from www.HostEng.com.

Update Booter
Use this dialog to update the module’s booter. Pick the booter file from disk. Booter files may 
be downloaded from www.HostEng.com.

Restore Factory Defaults
Use this button to reset all user configurable settings to the factory defaults. A warning dialog 
will appear to verify this action. Select OK to restore to the defaults.



Maintenance and 
Troubleshooting 166

ChapterChapterChapter

In This Chapter...
Isolating a Communication Problem.........................................................................6–2

Troubleshooting Chart...............................................................................................6–2

ERM Module Diagnostic LEDs....................................................................................6–4

Slave Module Diagnostic LEDs...................................................................................6–4

Using ERM Workbench for Troubleshooting.............................................................6–5

Reserved PLC Memory for ERM.................................................................................6–6

Using NetEdit for Troubleshooting............................................................................6–8

Diagnosing Network Cable Problems......................................................................6–10



Ethernet Remote Master User Manual, 2nd Edition, Rev. C - H24-ERM-M6–2

Chapter 6: Maintenance and Troubleshooting

Isolating a Communication Problem
If you are experiencing a problem communicating with an ERM module or one of its slaves, 
the problem can usually be isolated to one of four components of the communication link:

•	 Ethernet module itself (hardware or firmware)

•	 The setup of the Ethernet module

•	 Cabling or connections

•	 Other external influences, such as electrical noise, heavy communication 
traffic on the network or exceeding the power budget

Diagnostic Tools and Techniques
Several available tools and techniques can help you isolate a communication problem:

•	 The LEDs on the face of the module indicate the status of the 
link, the module, and the network communications.

•	 Replacing the module may determine whether the problem is in the module.

•	 NetEdit and the ERM Workbench display a list of the active modules 
on the network and their protocol and configuration settings.

•	 Cable testing devices can pinpoint short or open circuits or diagnose 
attenuation problems and other cabling problems.

Troubleshooting Chart
The following chart summarizes the different types of communication failures you could 
experience. In each case the CPU PWR LED must be on, and you must be attempting to 
communicate with the module in question.

NOTE: The ERM Workbench Utility allows the user to flash the error LED for 3 seconds to help identify the 
ERM module visually. Do not mistake this user initiated event with a true ERM error condition.

The meaning of the diagnostic LEDs is explained on page 6-4.

ERM Module LEDs Corrective Action

Off On FlashLegend:

Troubleshooting Chart

LINKGD
ACT

ERROR

LINKGD
ACT

ERROR
OR

Error ON Error Flashing

1. �Cycle power on the CPU Interface unit. This will clear 
the ERROR if it was due to a transient condition.

2. �Try another cable that you know works. Check pinouts 
(see page 3–7).

3. Try another port on the hub or another hub.
4. Replace module.
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ERM Module LEDs Corrective Action

Off On FlashLegend:

Troubleshooting Chart (Continued)

LINKGD
ACT

ERROR

No LEDs

LINKGD
ACT

ERROR

Only LINKGD ON

LINKGD
ACT

ERROR
OR

LINKGD
ACT

ERROR

LINKGD ON
ACT Flashing

LINKGD ON
ACT ON

1. �Try another cable between PC and hub.
2. �Try another port on the hub or another hub.
3. �Make sure you have not exceeded the recommended cable 

length for your network cable. The link signal could arrive 
with sufficient strength even though the data transmission 
does not.

4. �Could be related to Windows configuration. Consult 
Windows documentation.

1. �Try another cable that you know works. Check pinouts 
(see page 3–7).

2. Try another port on the hub or another hub.
3. Replace module.

1. �Try another cable between PC and hub or other 
module and hub.

2. �Try another port on the hub or another hub.
3. �Confirm that ERM module is in a usable slot in the 

PLC base (see pages 3–2 and 3–3) and that the CPU 
Interface and its firmware support the ERM module.

4. �Look for errors in the setup of the ERM module or in 
the communication program.

Note: This is also the indication of 
proper operation! Troubleshoot only if 
you are failing to exchange data.
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ERM Module Diagnostic LEDs

Note 1: The ERROR LED on H2-ERM or H4-ERM modules indicates a fatal internal error. Cycle power to 
clear the error. If the error will not clear, replace the module.

Note 2: The ERROR LED on H2-ERM100 or H4-ERM100 modules indicates that some error is present. 
Refer to troubleshooting section of this manual to determine the error. Example errors: 
•  Cannot communicate with an ECOM(100) or GS-EDRV(100). 
•  Hardware installed in a base does not match the hardware configuration. 
•  An analog module error bit is ON. 
•  Fatal error. If a fatal error has occurred ERM Workbench and NetEdit are unlikely to successfully 
   communicate with the ERM. Try cycling power to the ERM. If the error will not clear, replace the module.

Slave Module Diagnostic LEDs
EBC LEDs

Hx–EBCs LED Diagnostic information is located in the Troubleshooting Guidelines chapter 
in the Ethernet Base Controller Manual (H24–EBC–M) and for the T1H–EBC in (T1H–
EBC–M) manual.

Error Indicator
A specific ERM network condition that can cause the EBCs ERROR LED indicator to 
illuminate is if the watchdog timer times out. This can result from the slave being disconnected 
from the ERM network.

LED H2-ERM, H4-ERM H2-ERM100 H4-ERM100

STATUS N/A Blinks while module is booting. 
On solid when module is ready. N/A

LINKGD On when module has established communications with the connected Ethernet 
device, typically a switch.

ACTIVE Indicates network activity. May appear solid ON during heavy traffic.

ERROR
Indicates an internal fatal 
error of the ERM module. 
See Note 1.

Indicates an error from a network device or a fatal 
internal error of the ERM module. See Note 2.

100MBIT N/A On solid when linked at 100Mbps.
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Using ERM Workbench for Troubleshooting
ERM Workbench can be used for troubleshooting an ERM Ethernet remote I/O system. It 
allows you to:

•	 View slave status and Detailed ERM Statistics.

•	 See active modules on the network.

•	 Examine or change the slave module’s configuration settings.

Read from ERM
To view the current configuration in the ERM module, launch ERM Workbench and click on 
“Read from ERM” under the File menu or tool bar. The following ERM main configuration 
window will be displayed.

The ERM main configuration window lists the ERM’s Ethernet Address, IP Address, Module 
ID just below the menu to identify the connected ERM. If the fields are blank, select File > 
Read From ERM to read a specific ERM’s configuration.

In the Slave Status box, the status of a specific slave can be displayed by clicking on the 
slave number 1–16. The numbers are highlighted in either normal, green, yellow or red. 
Normal indicates that the slave is not configured. Green indicates the ERM is successfully 
communicating with that particular slave. Yellow indicates I/O is being updating, but some 
error exists within the I/O of that slave and that there are no I/O module errors in the slave. 
Red indicates I/O is not being updating or that the ERM is not communicating with that slave. 
A description of the error will be listed.

The network I/O modules and I/O points are listed by slave and slot number. For a PLC, the 
first two words of memory in the Discrete Input table is used for ERM/slave status information, 
and the first word of memory in the Discrete Output table is for Disable Slave Command 
bits. The PLC memory map information is not displayed if a WinPLC is selected as the CPU 
interface.
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Detailed ERM Statistics
Detailed ERM Statistics provides I/O Cycle Times, Total Retries to All Slaves and CPU 
Interface information. This information may be helpful when trying to diagnose a remote 
I/O network problem. The maximum I/O Cycle Time is the time for the ERM to 1) read the 
remote slave inputs and write the data to the CPU and 2) for the ERM to read the output data 
from the CPU and write the data to the remote slaves.

Reserved PLC Memory for ERM
The first two words of memory in the Discrete Input table is used for ERM/slave status 
information, and the first word of memory in the Discrete Output table is for Disable Slave 
Command bits. The default memory addresses DLX300/X300 and DLY300/Y300 are used in 
this example.

The Slave Status Bits can 
be monitored to detect if a 

slave is in error.

The ERM Status Word 
contains the ERM error 

code and Status Bits (see the 
following description and 
Error Codes in Appendix 
B). Bit 8 indicates that the 
ERM is disabling a slave.

The Disable Slave Bits can 
be used to disable a slave 

from communicating with 
the ERM module. Bit ON 
= disable that specific slave. 

RESET = re-enable the 
specific slave.

X
3
1
7

BSLBSM V40414

Slave Status Bits

X
3
0
0

Slave 1Slave 16

X
3
3
7

BSLBSM V40415

ERM Status Word

X
3
2
0

X
3
2
7

X
3
3
0

Status Bits Error Code

Y
3
1
7

BSLBSM V40514

Disable  Slave Bits

Y
3
0
0

Slave 1Slave 16

DLX
3
1
7

BSLBSM

Slave Status Bits

DLX
3
0
0

Slave 1Slave 16

DLX
3
3
7

BSLBSM

ERM Status Word

DLX
3
2
0

3
2
7

DLX
3
3
0

Status Bits Error Code

DLY
3
1
7

BSLBSM

Disable  Slave Bits

DLY
3
0
0

Slave 1Slave 16

DirectLOGICDo-more!
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Select Slaves Window
The left column displays the Ethernet Address, IP Address, Module ID and Model number of 
the modules currently on the remote I/O network. This means you are linking to the modules 
from your PC. If you are linking to a module but the ERM is failing to communicate with the 
module, you can conclude that:

•	 The module is working.

•	 The cabling is satisfactory from the PC to the hub and from the hub to the ERM module

•	 The hub is working.

•	 The problem may be an addressing issue. If the ERM is configured to use IP protocol, 
make sure that the IP Address for the ERM and slave is valid and unique. If the ERM is 
configured to use IPX protocol, make sure that either the Module ID or Ethernet Address 
in the slave is correct and unique.

If the ERM or slave module is not on the list, try clicking on either the IPX or UDP/IP radio 
button (Query is automatically done when the protocol in the center column is changed). 
Confirm that your PC has IPX and TCP/IP protocol loaded.

Make sure the desired network slaves are in the ERM’s Slave List. The right column displays 
the Slave Configuration of the specific slave that is selected in the ERM’s Slave List.

NetEdit can be accessed from this window. NetEdit is a software utility that can be used to 
set the Module ID, set an IP Address or configure the 405 EBCs for analog I/O modules if 
necessary. See the following section for details on NetEdit.
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Using NetEdit for Troubleshooting
NetEdit is a software utility within ERM Workbench which came with this manual. To review 
the procedures for accessing and using NetEdit, see Chapter 5. It allows you to:

•	 See active modules on the network.

•	 Examine and change the modules’ configuration settings.

•	 See the firmware revision number.

•	 Review statistical information about communication errors by type.
If you can see the ERM and slave modules on the list in the Module box (described below), 
you are linking to the module from your PC. If you are linking to the module but failing to 
communicate with the module, you can conclude that:

•	 The module is working.

•	 The cabling is satisfactory from the PC to the hub 
and from the hub to the ERM module.

•	 The hub is working.

•	 The problem is in one of the other components of the communication link.

Select a Module
The Module box shows the Ethernet 
Addresses of all modules which are 
currently linked to the NetEdit utility. 
If your ERM or slave module is not on 
this list, try the following:

•	 �Change Protocol selection 
and click on Query Network. See Change Protocol on the next page.

•	 Confirm that your PC has IPX or TCP/IP protocol loaded.

•	 Confirm that the module’s LINKGD LED is on.

NOTE: The Ethernet Address is permanently assigned at the factory, and it is recorded on a label on the 
side of the ERM module. See page 2-4 if you need help locating the label. It is recommended to record the 
module’s Ethernet Address on a label and affix it near the module in a visible location.

Module Information
The Module Information box provides the module Version, Booter and Dip switch settings, 
as well as, Ethernet Stats and Errors. Verify that all modules of the same type have the same 
firmware version.
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Ethernet Stats

If you are able to see the problem module on the list of modules currently active on the network, 
you can select the module to see the Ethernet Stats for that module. Select the module by 
clicking on the Ethernet Address in the Module box.

To begin a new statistical record, click the Reset Stats button.

The diagnostic information available in the Ethernet Stats box is:

•	 Missed Frames – frames lost due to unavailability of buffer space.

•	 �TX Collisions – detected when RXD+ and RXD– become active during a data 
transmission. Two devices are trying to communicate at the same time.

•	 Lost Packets – packets that overflow the queue.

•	 �Bad Packets – packets that fit the Ethernet standard but are 
not in the right format for the EBC module.

•	 �Unknown Type – a foreign command was received and could not be interpreted. 
This will probably happen only during software driver development.

•	 TX Errors – the Ethernet standard number of retries were attempted for a transmission.

Change Protocol
If you are experiencing a problem communicating from your PC 
to a module that does not appear on the list of active modules, try 
changing the protocol and clicking on Scan Network. You may 
be able to link to your module with the other protocol.

Replacing the ERM / Slave Module
If you set up your original ERM or slave module using NetEdit, you will need to duplicate the 
settings in the new module using the same procedure.

WARNING: Your system can be damaged if you install or remove system components before 
disconnecting the system power. To minimize the risk of equipment damage, electrical shock, or 
personal injury, always disconnect the system power before installing or removing any system 
component.



Ethernet Remote Master User Manual, 2nd Edition, Rev. C - H24-ERM-M6–10

Chapter 6: Maintenance and Troubleshooting

Diagnosing Network Cable Problems
If you are experiencing communication problems, swapping cables is one of the simplest 
diagnostic procedures you can perform. If the network operates correctly with a different cable, 
you have isolated and cured the problem. If possible, use a short run of cable to test the network 
because problems with longer cable runs can be more difficult to diagnose and are more often 
intermittent.

If you are unable to swap cables, verify the proper operation of all other network components. 
You probably have a cable problem if you have verified that your:

•	 ERM module is working correctly.

•	 ERM module configuration is correct.

•	 RLL program is correct.

•	 Hubs are working correctly.

•	 Windows configuration is correct.

•	 Network adapter card is the correct type, and it is working correctly.

It is a good maintenance practice to test network cables periodically and maintain a permanent 
record of cable characteristics. A number of cable test instruments are available to test 
10/100BaseT and 10BaseFL networks. These instruments will check the electrical or optical 
characteristics of your cabling, including:

•	 Continuity – This is a check to make sure the communication pairs are wired correctly, 
and that the wires are continuous from end to end. In the case of fiber optic network 
this is a test to be sure light is transmitted from one end of the cable to the other.

•	 Attenuation – This refers to the amount of signal loss over the cable segment 
at the signal frequency of interest. The 10/100BaseT specification allows 
for a maximum signal loss of 11.5 decibels (dB) for the entire link at the 
signal frequency used by 10Mbps Ethernet. The 10BaseFL specification 
calls for the optical loss in link segment to be no greater than 12.5 dB.

•	 Crosstalk – Crosstalk occurs when a signal in one pair of wires is 
electromagnetically coupled to an adjacent pair. This is critical for 
10/100BaseT networks which are susceptible to noise interference. 
10BaseFL networks are virtually immune to noise interference.

NOTE: Any significant difference between the cable characteristics of the transmitter and receiver can cause 
communication errors. 

Ethernet devices continually monitor the receive data path for activity as a means of verifying 
their link is working correctly. When the network is idle, each network device (including the 
ERM module) sends a periodic link test signal to verify that the network is working. If the link 
test signal or other network activity is not received periodically, the LINKGD LED on the 
ERM module is turned off.
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General Specifications
Specifications

H2–ERM / H2-ERM100 and H4-ERM / H4–ERM100 General Specifications

Module Type Ethernet I/O Communications Master Module

Quantity of Modules Defined by CPU, base configuration and power Per Basebudget

Quantity of Slaves per ERM 16 max.

Diagnostics LEDs, ERM Workbench, NetEdit

Communications H2-ERM / H4-ERM: 10BaseT Ethernet
H2-ERM100 / H4-ERM100: 10/100BaseT Ethernet

Data Transfer H2-ERM / H4-ERM: 10 Million bits per second
H2-ERM100 / H4-ERM100: 100 Million bits per second

Extension Port RJ45

Link Good Indicator (LINKGD) Green LED

Activity Indicator (ACT) Red LED

Error Indicator (ERROR) Red LED

Power Consumption H2-ERM / H4-ERM: 320mA @ 5VDC (Supplied by DL205/DL405 base)
H2-ERM100 / H4-ERM100: 300mA @ 5VDC (Supplied by DL205/DL405 base)

Operating Temperature 32° to 140° F (0° to 60° C)

Storage Temperature –4° to 158° F (–20° to 70° C)

Relative Humidity 30% – 95% RH (non-condensing)

Environmental Air No corrosive gases permitted

Networking Protocols Supported UDP/IP, IPX

Manufacturer Host Automation Products

Link Distance 100 meters (328 feet)



Ethernet Remote Master User Manual, 2nd Edition, Rev. C - H24-ERM-M A-3

Appendix A: General Specifications

H2–ERM–F / H4–ERM–F General Specifications
Module Type Ethernet I/O Communications Master Module

Quantity of Modules Per Base Defined by CPU, base configuration and power budget

Quantity of Slaves per ERM 16 max.

Diagnostics LEDs, ERM Workbench , NetEdit

Communications 10BaseFL Ethernet (fiber optic)

Data Transfer 10 Million bits per second

Extension Port ST-style fiber optic connector

Link Good Indicator (LINKGD) Green LED

Activity Indicator (ACT) Red LED

Error Indicator (ERROR) Red LED

Power Consumption 450mA @ 5VDC (Supplied by DL205/DL405 base)

Operating Temperature 32° to 140° F (0° to 60° C)

Storage Temperature  –4° to 158° F (–20° to 70° C)

Relative Humidity 30% – 95% RH (non-condensing)

Environmental Air No corrosive gases permitted

Networking Protocols 
Supported

UDP/IP, IPX

Manufacturer Host Automation Products

Link Distance Up to 2,000 meters (2km), 6,560ft (1.2 miles)
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Ethernet Standards
Various institutes and committees have been involved in establishing Ethernet data 
communication standards. These specification standards assure Ethernet network 
compatibility for products from a broad variety of manufacturers. 

The ERM module complies with American National Standards Institute (ANSI) and 
Institute of Electrical and Electronic Engineers standard ANSI/IEEE 802.3, Carrier Sense 
Multiple Access with Collision Detection (CSMA/CD) Access Methods and Physical 
Layer Specifications. This standard has been adopted by the International Organization for 
Standardization (ISO) as document ISO/IEC 8802–3. 

The Electronic Industries Association (EIA) and Telecommunications Industries 
Commercial Building Telecommunications Wiring Standard designated EIA/TIA–568A 
defines implementation of 10BaseT (twisted pair) and 10BaseF (fiber optics) for Ethernet 
communications.

The same two organizations produced EIA/TIA TSB40–Additional Transmission 
Specifications for Unshielded Twisted-Pair Connecting Hardware. The purpose of this 
document is to specify transmission performance requirements and connecting hardware 
requirements.
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ERM Status Word / Resetting the Slave
The ERM Status Word contains the current ERM Error Code in the Least Significant Byte 
and the Status Bits in the Most Significant Byte. Currently, only bit 8 is used in the MSB 
designating the ERM is disabling Slave.

When using the Slave Disable Bits, the ERM must recognize the request to disable a slave 
before attempting to re–enable that slave. This closed loop feedback is necessary due to the 
asynchronous scans of the ERM and PLC. X330 (DirectLOGIC) or DLX330 (Do-more!) is 
the only feedback bit for ALL slave disabling bits (DLY300/Y300 – DLY317/Y317). Either 
disable multiple slaves all on the same scan or serialize the disable process by using ladder logic 
interlocks.

Use the following ladder logic code to manually reset a slave. For example, use this resetting 
method when “Hot Swapping” a Terminator I/O module on a slave that is set up to be 
manually reset using ladder logic. The default for the Terminator EBC is automatic rescan after 
“Hot Swapping” an I/O module.

ERM Diagnostics
The first two words of memory in the Discrete Input table is used for ERM/slave status 
information, and the first word of memory in the Discrete Output table is for Disable Slave 
Command bits. The default memory addresses DLX300/X300 and DLY300/Y300 are used in 
this example.

The Slave Status Bits can 
be monitored to detect if a 

slave is in error.

The ERM Status Word 
contains the ERM error 

code and Status Bits (see the 
following description and 
Error Codes in Appendix 
B). Bit 8 indicates that the 
ERM is disabling a slave.

The Disable Slave Bits can 
be used to disable a slave 

from communicating with 
the ERM module. Bit ON 
= disable that specific slave. 

RESET = re-enable the 
specific slave.
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DirectLOGIC Example

C0

PD

C200

Direct SOFT

C0

SET

Y300

Y300

RST 

Y300X330

Event occurs to reset Slave 1

Disable Slave 1

Wait to re–enable Slave 1 until X330 (ERM
Disable Request Bit) is ON.

C0

PD

C200

C0

SET

DLY300

DLY300

RST 

DLY300DLX330

Event occurs to reset Slave 1

Disable Slave 1

Wait to re–enable Slave 1 until DLX330 (ERM
Disable Request Bit) is ON.

Do-more

Do-more! Example
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ERM Status Word Error Codes
The following table describes the errors that will be reported to the ERM Status Word.

Error Code 
(Decimal) Description

E0 No error.

E3 Configured bit inputs overlap system input bits.

E4 Configured bit outputs overlap system output bits.

E5 More than one device found with same module ID.

E6 More than one device found with same IP address.

E7 ERM could not read slave’s error information – slave not responding.

E8 Device not supported; may be old firmware or configuration error.

E9 Device timed out on a function request after retries.

E13 Gateway address needed, but not specified

E14 Subnet mask needed, but not specified.

E15 Configured module ID’s do not match modules in device.

E16 Number of bit inputs specified in ERM is less than actual in slaves.

E17 Number of bit outputs specified in ERM is less than actual in slaves.

E18 Number of word inputs specified in ERM is less than actual in slaves.

E19 Number of word outputs specified in ERM is less than actual in slaves.

E20 Invalid base definition for this device.

E21 ERM has not been configured

E22 Overflow of internal buffer E22.

E23 Overflow of internal buffer E23.

E24 Overflow of internal buffer E24.

E25 Overflow of internal buffer E25.

E26 Overflow of internal buffer E26.

E27 Configuration error: input words configured not enough.

E28 Configuration error: output words configured not enough.

E221 ERM to CPU backplane error.

E223 PLC family unknown.

E224 ERM to CPU backplane error.

E225 Backplane code error returned from PLC.

E226 General backplane error returned from PLC.

E227 Timeout on PLC backplane error.

E228 ERM to CPU backplane error.

E231 ERM to CPU backplane error.
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Reading ERM Statistics
Reading ERM Statistics using Ladder Logic with DirectLOGIC  

The following ladder logic example reads the ERM statistics from the ERM module. 12 words 
(24 bytes) of statistical data are stored in the ERM’s memory starting at V0 (TA0). Use slave 
address of 90 when reading ERM statistics. In the example below, the RX instruction stores 
the statistical data from the ERM module to V1400 – V1413 in the CPU’s memory. More 
information on the RX network instruction can be found in the PLC User Manual. The ERM 
module is located in slot 2 of the I/O base in this example. Refer to the Special Relays Appendix 
in the PLC User Manual to identify each slot’s Module Busy and Comm Error bits.

The format of the ERM’s statistics is as follows:

PLC Address Description of Statistic Format

 Addr + 0  Minimum I/O Scan in milliseconds  Word / Decimal

 Addr + 1  Maximum I/O Scan in milliseconds  Word / Decimal

 Addr + 2,3  Total accumulated time in milliseconds  DWord / Decimal

 Addr + 4,5  Total number of I/O Scans  DWord / Decimal

 Addr + 6,7  Number of PLC Read Retries  DWord / Decimal

 Addr + 10,11  Number of PLC Write Retries  DWord / Decimal

 Addr + 12,13  Number of Slave Retries  DWord / Decimal

DirectSOFT

LD

K0290

The constant value K0290
specifies the slot number (2) 
and to read ERM statistics (90).

LD

K24

The constant value K24
specifies the number of
bytes to be read (12 words).

LDA

O 1400

Octal address 1400 is
converted to 300 HEX and
loaded into the accumulator.
V1400 is the starting
location for the Master CPU
where the specified data will
be read into.

RX

TA0

V0 (TA0) is the starting
location in the ERM where
the specified data will be
read from.

C200SP125SP124
Module Busy Slot 2 Comm Error Slot 2

SP124

SET

C200

RST

C200
Module Busy Slot 2
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Reading ERM Statistics using Ladder Logic with Do-more!
The following ladder logic example reads the ERM statistics from the ERM module. 12 words 
(24 bytes) of statistical data are stored in the ERM’s memory starting at V0 (TA0). Use slave 
address of 90 when reading ERM statistics. In the example below, the DLRX instruction 
stores the statistical data from the ERM module to V100 – V111 in the CPU’s memory. More 
information on the DLRX network instruction can be found in the Do-more! help file. The 
ERM module is located in slot 2 of the I/O base in this example. Interlocking is not required 
in Do-more!.  Turning on C10 will result in one read of the ERM.

PLC Address Description of Statistic Format

Addr + 0 Minimum I/O Scan in milliseconds Word / Decimal

Addr + 1 Maximum I/O Scan in milliseconds Word / Decimal

Addr + 2,3 Total accumulated time in milliseconds DWord / Decimal

Addr + 4,5 Total number of I/O Scans DWord / Decimal

Addr + 6,7 Number of PLC Read Retries DWord / Decimal

Addr + 8,9 Number of PLC Write Retries DWord / Decimal

Addr + 10,11 Number of Slave Retries DWord / Decimal
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Reading Error Codes from Slaves
Reading Error Codes from Slaves with DirectLOGIC 

The following ladder logic example reads the Error Codes from three slaves (1–3).  The slaves’ 
error data is stored in their memory starting at V0 (TA0). Up to 36 words (72 bytes) of error 
codes can be read from a slave depending on the number of bases and I/O modules (slots) used 
per slave.  In the example below, the RX instruction stores the Error data read from Slave 1 
into V2000 – V2013 and from Slave 2 into V2020 – V2033, etc. in the CPU’s memory.  More 
information on the RX network instruction can be found in the PLC User Manual The ERM 
module is located in slot 2 of the 205 I/O base in this example.  Refer to the Special Relays 
Appendix in the PLC User Manual to identify each slot’s Module Busy and Comm Error bits. 
Refer to the Slave Diagnostic Word Memory Table in this chapter for a description of the 
word information read from the slaves.  This example reads words V0 – V11 (24 bytes) from 
the slaves.

Direct SOFT

K0201

The constant value K0201
specifies the ERM slot number (2)
and EBC SLAVE base (1).

LD
K24

The constant value K24
specifies the number of
bytes to be read (12 words).

LDA
O 2000

Octal address 2000 is converted to 400
HEX and loaded into the accumulator.
V2000 is the starting location for the
Master CPU where the specified data
will be read into.

RX
TA0

V0 (TA0) is the starting
location in the slave module
where the specified data will
be read from.

SP125SP124C60

Module Busy Comm Error 

X300

Slave 1
Slot 2Slot 2Error bit

LD

VC60

Module Busy 

SP7SP124

=
K0

VX300
=

K0

C63

SR

C77

C60

Continued on next page
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Continued from previous page

Direct SOFT

LD
K0202

The constant value K0202
specifies the slot number (2)
and slave 2.

LD
K24

The constant value K24
specifies the number of
bytes to be read (12 words).

LDA
O 2020

Octal address 2020 is converted to HEX
and loaded into the accumulator. V2020
is the starting location for the Master
CPU where the specified data will be
read into.

RX
TA0

V0 (TA0) is the starting
location in the slave module
where the specified data will
be read from.

SP125SP124C61

Module Busy Comm Error 

X301

Slave 2
Slot 2Slot 2Error bit

LD
K0203

The constant value K0203
specifies the slot number (2)
and slave 3.

LD
K24

The constant value K24
specifies the number of
bytes to be read (12 words).

LDA
O 2040

Octal address 2040 is converted to HEX
and loaded into the accumulator. V2040
is the starting location for the Master
CPU where the specified data will be
read into.

RX
TA0

V0 (TA0) is the starting
location in the slave module
where the specified data will
be read from.

SP125SP124C62

Module Busy Comm Error 

X302

Slave 3
Slot 2Slot 2Error bit

Continued from previous page
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Reading Error Codes from Slaves with Do-more!
The following ladder logic example reads the Error Codes from slaves (1–3). The slaves’ error 
data is stored in their memory starting at V0 (TA0). Up to 36 words (72 bytes) of error codes 
can be read from a slave depending on the number of bases and I/O modules (slots) used per 
slave. In the example below, the DLRX instructions read 24 bytes of Error data from Slave 1 
to CPU memory V200 – V211, from Slave 2 to CPU memory V212 – V223 and from Slave 
3 to CPU memory V224 – V235. More information on the DLRX network instruction can 
be found in the Do-more! help file. The ERM module is located in slot 2 of the 205 I/O base 
in this example. Refer to the Slave Diagnostic Word Memory Table on the following page for a 
description of the word information read from the slaves. Interlocking reads to the three slaves 
is not required. The CPU will manage the reads. Turning on C13 will result in one read of Slave 
1, then a read of Slave 2, then a read of Slave 3.
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Slave Diagnostic Word Memory
The following table describes the Word information that is obtained when a slave’s diagnostic 
information is read (RX) by the PLC CPU into its memory. Applies to DL205/405 and 
Terminator EBC modules.

Word Description

V +0 Current slave error code: Bits 0 – 11
Type of Error: Bits 12–15: ( Bit 12 SET = I/O Error Condition;SET = I/O Warning) Bit 13 

V +1 Slave module slot in error (slots 0 – 15).

V +2 Slave module slot in error (slots 16 – 31).

V +3 Slave’s Last error code

V +4 Extended error code module in slot 0.

V +5 Extended error code for module in slot 1.

V +6 Extended error code for module in slot 2.

V +7 Extended error code for module in slot 3.

V +8  Extended error code for module in slot 4.

V +9 Extended error code for module in slot 5.

V +10 Extended error code for module in slot 6.

V +11 Extended error code for module in slot 7.

V +12 Extended error code for module in slot 8 or base 1 slot 0.

V +13 Extended error code for module in slot 9 or base 1 slot 1.

V +14 Extended error code for module in slot 10 or base 1 slot 2.

V +15 Extended error code for module in slot 11 or base 1 slot 3.

V +16 Extended error code for module in slot 12 or base 1 slot 4.

V +17 Extended error code for module in slot 13 or base 1 slot 5.

V +18 Extended error code for module in slot 14 or base 1 slot 6.

V +19 Extended error code for module in slot 15 or base 1 slot 7.

V +20 Extended error code for module in slot 16 or base 2 slot 0.

V +21 Extended error code for module in slot 17 or base 2 slot 1.

V +22 Extended error code for module in slot 18 or base 2 slot 2.

V +23 Extended error code for module in slot 19 or base 2 slot 3.

V +24 Extended error code for module in slot 20 or base 2 slot 4.

V +25 Extended error code for module in slot 21 or base 2 slot 5.

V +26 Extended error code for module in slot 22 or base 2 slot 6.

V +27 Extended error code for module in slot 23 or base 2 slot 7.

V +28 Extended error code for module in slot 24 or base 3 slot 0.

V +29 Extended error code for module in slot 25 or base 3 slot 1.

V +30 Extended error code for module in slot 26 or base 3 slot 2.

Continued on following page
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Continued from previous page

Word Description
V +31 Extended error code for module in slot 27 or base 3 slot 3
V +32 Extended error code for module in slot 28 or base 3 slot 4.
V +33 Extended error code for module in slot 29 or base 3 slot 5.
V +34 Extended error code for module in slot 30 or base 3 slot 6.
V +35 Extended error code for module in slot 31 or base 3 slot 7.
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Current / Last State Slave Error Codes
The following table lists the Current and Last State Slave error codes for Word 0 and Word 3 in 
the Slave Diagnostic Word Memory Table. Applies to 205/405 and Terminator EBC modules.

Error Code 
(Decimal) Description

E0 No error.
E121 Channel failure.
E122 Unused analog input channels exist.

E139 Broken transmitter on one of the analog input channels (if supported by analog module)

E142 Multiple channels failed.

E153

The module which was in this slot is no longer responding. User has removed a module in 
a Terminator I/O slave system.
If Automatic Reset (default) is enabled for this slave, it will reset itself once the 
replacement module is inserted.
If Manual Reset is enabled for this slave, the user must 1) SET the slave disable flag for 
that slave in the first diagnostic output word, 2) wait for bits 8–15 in second diagnostic 
input word to equal 1, then 3)RESET the slave disable flag in the first diagnostic output 
word.

E154 I/O configuration has changed. See E153 for reset methods.

E200–E216 Unused analog input channels exist at channel xx (1–16), where xx = Value –200.
(Example: E212 indicates unused analog channel exists at channel 12.
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Extended Slave Error Codes
The following table lists the Extended Slave error codes for Words 4–35 in the Slave Diagnostic 
Word Memory Table. Applies to DL205/405 and Terminator EBC modules.

Error Code 
(Decimal) Description

E32–E63

Bitwise error where bit 5 is always SET. Look at bit 0 thru bit 4 to get a possible list of 
errors. Example 34 decimal = 22 hexadecimal (Bit 5 SET and Bit 1 SET).
BIT
 0
 1
 2
 3
 4 
 5

Type of Error
Terminal block off
External P/S voltage low
Fuse blown
Bus error 
Module initialization error (intelligent module)
Fault exists in module (this bit is SET if any of the above bits are SET)

E117 Write attempt to an invalid analog channel.

E119 Data not valid. Subnet mask or IP address not allowed // EBC SDK data packet not 
constructed properly.

E121 Analog input channel error.

E122 Unused analog input channels exist.

E139 Broken transmitter on one of the analog input channels.
E142 Channel failure.
E146 Communications failure. Hitachi drive on–board relay set.

E153 

The module which was in this slot is no longer responding. User has removed a 
module in a Terminator I/O slave system. If Automatic Reset is enabled for this slave, 
it will reset itself once the replacement module is inserted. If Manual Reset is enabled 
for this slave, the user must 1) SET the slave disable flag for that slave in the first 
diagnostic output word, 2) wait for bits 12–15 in second diagnostic input word to 
equal 1, then 3) RESET the slave disable flag in the first diagnostic output word.

E154 One or more new modules has been inserted into the base. See E153 for reset 
methods.

E155 Terminator module status error. One or more of the modules in the T1H–EBC base 
has an error. For more detail check extended errors

E200– E216 Unused analog input channels exist at channel xx (1–16), where xx = Value –200.
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ERM and ERM Workbench Factory Default Settings
The following factory default settings or values can be changed by using the tools within the 
ERM Workbench utility.

Item Default
Protocol IPX

Address Mode Ethernet Address

ERM Timeout to Slave 25ms

ERM Retries 1

Slave Watchdog 250ms

ERM Pet Slave Watchdog 0 (disabled)

ERM Consecutive Comm Failures to Slave 
Before Placing Slave in Standby Mode 5

Slave Padding 0

Bit Input Address DirectLOGIC: V40414 (X300); 
Do-more!: (DLX300)

Bit Output Address DirectLOGIC: V50514 (Y300)
Do-more!: (DLY300)

Word Input Address DirectLOGIC: V2000
Do-more!: DLV2000

Word Output Address DirectLOGIC: V2100
Do-more!: DLV2100

Standby Cycle Time 500ms

Unsupported Slave Cycle Time 1000ms

PLCScan Timeout 100ms



Mapping ERM Slave 
I/O in a Think & Do 
WinPLC System DDD

AppendixAppendixAppendix

In This Appendix...
Mapping ERM Slave I/O Points................................................................................. D–2

NOTE: Think & Do software (PC-TD8-USB & PC-TD8-WEB4-USB) has been 
retired and is no longer supported. Please consider updating to Do-more 
software for your project.
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Mapping ERM Slave I/O Points
The purpose of this appendix is to identify that the Think & Do ConnectivityCenter tool is 
used to configure (map) the ERM remote slave I/O points to Data Items. We recommend 
that you are familiar with the “Getting Started” and “Creating a Project” chapters in the 
Think & Do Studio Learning Guide before attempting to configure the ERM I/O in 
ConnectivityCenter.

NOTE: The ERM and its slaves need to be configured using ERM Workbench before using Think & Do 
ConnectivityCenter to map the ERM slave I/O points to Data Items.

Launching Connectivity Center Tool
To launch Connectivity Center:

1) Launch Think & Do Studio ProjectCenter from the Windows desktop by clicking on 
Start > Programs > Think & Do Studio > ProjectCenter. Or, click on the ProjectCenter icon 
to start.

2) Click on the File Menu and either Open your Think & Do Project or select New.

3) Within ProjectCenter select Windows CE – Think & Do WinPLC as the Runtime 
Target.

4) Then click Tools > ConnectivityCenter to launch ConnectivityCenter. Or, click on the 
ConnectivityCenter shortcut in the Project Explorer.

5) Once in ConnectivityCenter click on Configuration > Connect or click on the Connect 
toolbar button.

Connecting to the WinPLC Base I/O
ConnectivityCenter will draw a picture of your WinPLC / ERM I/O network. Clicking on 
the Backplane I/O Driver in the Board view window 
will display the WinPLC I/O base. ERM Module

Board View

Clicking on Backplane 
I/O displays the 

WinPLC I/O
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Connecting to the ERM Slave I/O
Clicking on the Ethernet Remote Master Driver in the Board view window will display the 
ERM slave I/O base(s).

Mapping I/O Points to Data Items
This procedure is discussed in detail in the “Creating a Project” chapter in the Think & Do 
Studio Learning Guide. This will map your real world I/O to Data Items.

Board View

Clicking on Ethernet 
Remote Master Driver 

displays the ERM 
slave I/O bases

ERM Slave 1 I/O Base

Scroll down to view 
next slave

ERM Slave 2 I/O Base
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Analog Output Module Control Byte
Terminator I/O analog voltage and current output and combination analog modules require 
configuring via the module control byte. Analog input modules do not require configuration. 
The DirectLOGIC example below shows an ERM network Terminator I/O slave with a 
discrete input module in slot 1, an analog voltage output module in slot 2 and a combination 
analog current module in slot 3. Note that the module control bytes are automatically mapped 
to the “Y” data type registers. The bits within the module control byte are used to enable or 
disable the analog outputs, select bipolar or unipolar output and select the voltage or current 
output range. For Do-more! applications, the control bits are mapped to DLY addresses, an 
example is shown below. 

T1F-08DA-2

Module Control Byte for 
each analog output module

T1F-8AD4DA-1

Control Bytes are 
mapped to DLY 
addresses in Do-more! 
applications

DirectLOGIC

Do-more!

T1F-08DA-2

T1F-8AD4DA-1
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The table below defines the bits of an analog module control byte. Example “Y” bit addresses 
are listed for the analog module control bytes from the ERM network example on the previous 
page, along with their equivalent Do-more! addresses. The module control byte addresses will 
vary depending on the location of the analog module in the system, the number of slaves, the 
amount of output modules used in an ERM network and the starting discrete output address 
that is user specified. ERM Workbench will list the appropriate control byte for any Terminator 
analog module that requires configuration.

The following example ladder logic code configures the analog output and combination analog 
modules used in the previous examples. The T1F–08DA–2 is configured for outputs enabled 
with 10V bipolar range. The T1F–8AD4DA–1 is configured for outputs enabled with 4–20mA 
unipolar range. The RST instruction can be used to reset the bits, if necessary.

Module Control Byte of 8 and 16-Channel Analog Output Modules and
Analog Combination Modules

Bit Definitions Example Bit Addresses for 
T1F–08DA–2

Example Bit Addresses for 
T1F–8AD4DA–1

Bit 0
Outputs Enable 
0 = All outputs OFF 
1 = All outputs Enabled

DL: Y320
Do-more!: DLY320

DL: Y330
Do-more!: DLY330

Bit 1
Unipolar / Bipolar 
0 = Unipolar selected 
1 = Bipolar selected

DL: Y321
Do-more!: DLY321

DL: Y331
Do-more!: DLY331

Bit 2
5V / 10V Range 
0 = 5V range 
1 = 10V range

DL: Y322
Do-more!: DLY322

DL: Y332
Do-more!: DLY332

Bit 3
0–20 mA / 4–20 mA Range 
0 = 0–20 mA range 
1 = 4–20 mA range

DL: Y323
Do-more!: DLY323

DL: Y333
Do-more!: DLY333

Bit 4–7 Reserved for system use – –

Y320

SET

SP0

DirectSOFT

SET

Y321

First scan enables the module’s outputs

Select 10 V range

Configure T1F–08DA–2

Y330

SET

SP0

SET

Y333

Select 4–20mA range

Configure T1F–8AD4DA–1

First scan enables the module’s outputs

Y322

SET

Select bipolar range

DirectSOFT
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Do-more! Designer
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H2-EBC(100) Analog Module Addressing - H2/4-ERM(100)
When using an ERM to EBC configuration, the analog module data in the H2-EBC(100) 
base is mapped to V-memory or Discrete I/O.  Certain Diagnostics Data is not automatically 
mapped. If needed, the Diagnostics Data can be accessed as described in H24-ERM-M 
Appendix B.

The ERM Workbench software will tell you what the mapping is for each I/O module in the 
H2-EBC(100) base. Once you have configured the H2-ERM(100) or H4-ERM(100) using 
ERM Workbench you will get a screen similar to the following:

For the example above, the I/O configuration for Slave 1 is:

Slot 0 = F2-04THM 
Slot 1 = F2-8AD4DA-1 
Slot 2 = F2-08AD-1 
Slot 3 = F2-04RTD 
Slot 4 = D2-12TR 
Slot 5 = F2-4AD2DA 
Slot 6 = F2-04AD-2 
Slot 7 = F2-04AD-1

Use the addresses shown in the ERM Workbench along with the following table to access the 
analog I/O with your ERM master.

For example, to configure the input resolution of the F2-8AD4DA-1 module located in Slot 1 
of the system, the data provided above along with the table below would show that V memory 
location V2104 is required. Also, to read the current temperature detected by Channel 3 of the 
RTD module in Slot 3, V memory location V2026 is required.
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H2-EBC(100) Analog Module Addressing - H2-ERM(100)

Part Number Channel Data Module Configuration Data Diagnostics Data*

F2-04AD-1 (L)
F2-04AD-2 (L)

Input Words:
Word 1 = Ch1 
Word 2 = Ch2 
Word 3 = Ch3 
Word 4 = Ch4

None

No Broken Transmitter Detection
If No 24VDC or No Terminal Block:
•  All channels = 0 counts 
•  ‘Error’ = 121** 
•  ‘Other’ = Cycles 1 thru 3***

F2-08AD-1

Input Words:
Word 1 = Ch1 
Word 2 = Ch2 
Word 3 = Ch3 
Word 4 = Ch4 
Word 5 = Ch5 
Word 6 = Ch6 
Word 7 = Ch7 
Word 8 = Ch8

None

Channels with broken transmitter:
•  Channel=0 counts 
•  ‘Error’ =121** 
•  ‘I/O Module Status Word 1’ = 
Channel Number**
If No 24VDC or No Terminal Block:
•  All channels = 0 counts 
•  ‘Error’ =121** 
•  ‘Other’ = Cycles 1 thru 7***

F2-08AD-2

Input Words:
Word 1 = Ch1 
Word 2 = Ch2 
Word 3 = Ch3 
Word 4 = Ch4 
Word 5 = Ch5 
Word 6 = Ch6 
Word 7 = Ch7 
Word 8 = Ch8

None

No Broken Transmitter Detection
If No 24VDC or No Terminal Block:
•  All channels = 0 counts 
•  ‘Error’ =121** 
•  ‘Other’ = Cycles 1 thru 7***

F2-4AD2DA

Input Words:
Word 1 = Ch1 
Word 2 = Ch2 
Word 3 = Ch3 
Word 4 = Ch4
Output Words:
Word 1 = Ch1 
Word 2 = Ch2

None

No Broken Transmitter Detection
If No 24VDC or No Terminal Block:
•  All channels = 0 counts 
•  ‘Error’ =121** 
•  ‘Other’ = Cycles 1 thru 3***

F2-8AD4DA-1

Input Words:
Word 1 = Ch1 
Word 2 = Ch2 
Word 3 = Ch3 
Word 4 = Ch4 
Word 5 = Ch5 
Word 6 = Ch6 
Word 7 = Ch7 
Word 8 = Ch8
Output Words:
Word 1 = Ch1 
Word 2 = Ch2 
Word 3 = Ch3 
Word 4 = Ch4

Output Words:
Word 5 = Input Resolution 
Word 6 = N/A 
Word 7 = Track and Hold 
Word 8 = Not Used 

Channels with broken transmitter:
•  Channel=0 counts 
•  ‘Error’ = 142** 
•  ‘I/O Module Status Word 1’ = Bit 
On for Each Channel with Broken 
Transmitter**
If No 24VDC or No Terminal Block:
•  All channels = 0 counts 
•  ‘Error’ =142** 
•  ‘Other’ = 0xFF***

** See Extended Slave Error Codes in Appendix B for further details.

* �Diagnostics Data is not automatically mapped. If needed, the Diagnostics Data can be accessed via ERM 
Workbench or ladder as described in H24-ERM-M Appendix B.

*** �‘Other’ is a field accessible only in ERM Workbench by clicking the button: Slave N’s Error List. This field 
cannot be read programmatically.
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Appendix F: H2-EBC(100) Analog Module Addressing

H2-EBC(100) Analog Module Addressing - H2-ERM(100)

Part Number Channel Data Module Configuration Data Diagnostics Data*

F2-8AD4DA-2

Input Words:
Word 1 = Ch1 
Word 2 = Ch2 
Word 3 = Ch3 
Word 4 = Ch4 
Word 5 = Ch5 
Word 6 = Ch6 
Word 7 = Ch7 
Word 8 = Ch8
Output Words:
Word 1 = Ch1 
Word 2 = Ch2 
Word 3 = Ch3 
Word 4 = Ch4

Output Words:
Word 5 = Input Resolution 
Word 6 = Range Selection 
Word 7 = Track and Hold 
Word 8 = Not Used 

No Broken Transmitter Detection
If No 24VDC or No Terminal Block:
•  All channels = 0 counts 
•  ‘Error’ =121** 
•  ‘Other’ = 0xFF***

F2-04THM
F2-04RTD

Input Words:
Word 1 = Ch1 
Word 2 = Ch2 
Word 3 = Ch3 
Word 4 = Ch4

None

Channels with broken transmitter:
•  Channel=0 counts 
•  ‘Error’ = 142d** 
•  ‘I/O Module Status Word 1’ = Bit 
On for Each Channel with Broken 
Transmitter**
If No 24VDC or No Terminal Block:
•  All channels = 0 counts 
•  ‘Error’ =121** 
•  ‘Other’ = 0x0F***

F2-02DA-1(L)
F2-02DA-2(L)

Output Words:
Word 1 = Ch1 
Word 2 = Ch2

None None

F2-02DAS-1
F2-02DAS-2

Output Words:
Word 1 = Ch1 
Word 2 = Ch2

None None

F2-08DA-1
F2-08DA-2

Output Words:
Word 1 = Ch1 
Word 2 = Ch2 
Word 3 = Ch3 
Word 4 = Ch4 
Word 5 = Ch5 
Word 6 = Ch6 
Word 7 = Ch7 
Word 8 = Ch8

None None

* �Diagnostics Data is not automatically mapped. If needed, the Diagnostics Data can be accessed via ERM 
Workbench or ladder as described in H24-ERM-M Appendix B.

** See Extended Slave Error Codes in Appendix B for further details.

*** �‘Other’ is a field accessible only in ERM Workbench by clicking the button: Slave N’s Error List. This field 
cannot be read programmatically.
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Appendix F: H2-EBC(100) Analog Module Addressing

F2-04RTD Example (Module in Slot 3)

Using the ‘ERM Workbench’ dialog below and the ‘H2-EBC(100) Analog Module Addressing 
- H2-ERM(100)’ chart above, we can find the addresses that contain channel data for the 
F2-04RTD module in Slot 3. Diagnostics Data is not automatically mapped. If needed, the 
Diagnostics Data can be accessed via ERM Workbench or ladder as described in H24-ERM-M 
Appendix B.

Input Channel Address Error Words

Channel 1 V2004

The Slave Diagnostic Word for slot 3 would be 
mapped to V + 7 (the eighth address in your 
chosen V-memory range). The H24-ERM-M 
manual Appendix B contains an example. 

Channel 2 V2005

Channel 3 V2006

Channel 4 V2007
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